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  Abstract 

The UWB (Ultra-Wideband) technology is a short range wide-band radio technology specified for device to 

device communication operating in unlicensed spectrum. It is an RF positioning technology that enables 

accurate and secure peer-to-peer ranging between mobile devices with robust resistance to interference 

while consuming very low energy and coexisting well with other radio communication systems. UWB is used 

for a variety of different applications, such as asset tracking, secure payment, personal tracker, real time 

location services and keyless access and start of a vehicle etc. According to ABI Research forecasts, there 

will be well over 1 billion UWB annual device shipments by 2026. Almost every smart phone shipped in 2026 

will support UWB services [1]. 

Talking about testing aspect of a UWB device, in general two test methodologies can be adopted as other 

wireless products, either the traditional testing mode (so-called conducted test mode) with wired RF 

connection between the test measurement equipment and device under test (DUT) or over the air (OTA) test 

mode in an OTA anechoic chamber. Sometimes, it is not always possible or necessary to perform the tests 

under conducted mode due to the limiting factors, e.g. cost, space, complexity and direct access to the RF 

connectors of the product. In this case, OTA testing is then becoming a non-evitable approach. Moreover, 

OTA testing reflects the usage of DUT in a real condition.  

In this application note, R&S® OTA test solution covering transmitter (Tx), receiver (Rx) and Time of Flight 

(ToF) testing in Wireless Automated Testing (WMT) environment is described. The measurement results 

throughout the whole document are based on NXP Trimension™ NCJ29D5 UWB automotive IC.  

Testing of a UWB device in conducted mode can be referred in [2] and more automotive vehicle access 

control test solutions from R&S® can be found under this Link. 

The remaining of this document is organized in the following way: 

Chapter 1 outlines the UWB fundamentals  

Chapter 2 briefly introduces the OTA basics 

Chapter 3 describes the UWB OTA test solution in great details, incl. hardware/software requirements of the 

test solution, insight of Tx, Rx and ToF testing 

In Appendix, some useful information in association with the described test solution are provided for further 

reference. 

The following abbreviations are used for R&S® products throughout this application note: 

R&S®CMP200 radio communication tester is referred to as CMP200 

R&S®CMQ200 High Shielding (HS) shielding cube is referred to as CMQ200 

R&S®CMQ500 shielding cube is referred to as CMQ500 

R&S®CM-Z300A accessory kit for UWB Time of Flight (ToF) measurements for CMP200 is referred to as ToF 

Kit 

R&S®SP6T RF connection kit is referred to as RF switch 

R&S®WinIQSIM2 signal generation software is referred to as WinIQSIM 

It is assumed that the reader of this application note has fundamental understanding of UWB PHY. If not, 

then please refer to the UWB white paper [3] for more detailed overview on the fundamentals, testing and 

certification or UWB IEEE 802.15.4 [4] / IEEE 802.15.4z standard [5]. 

 

https://www.rohde-schwarz.com/us/solutions/test-and-measurement/automotive/automotive-connectivity-and-infotainment/vehicle-access-control/connectivity-remote-keyless-entry_231908.html
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1 UWB Fundamentals 

This chapter describes the fundamentals of UWB technology. 

1.1 Standards 

High rate pulse repetition (HRP) UWB PHY is standardized by IEEE802.15.4, a task working group within the 

IEEE 802.15 family. In that standard, the HRP UWB PHY protocol data unit (PPDU), modulation, RF 

requirements (incl. operating frequency bands, channel assignments, baseband impulse response, transmit 

power spectrum density PSD mask etc.) are defined. 

IEEE802.15.4z standard is an amendment to IEEE802.15.4 where enhanced ranging device (ERDEV) based 

on HRP UWB PHY, so-called HRP-ERDEV, is specified. HPR-ERDEV can be operated in two modes, i.e. 

base pulse repetition frequency (BPRF) and higher pulse repetition frequency (HPRF) mode, at a nominal 64 

MHz and 124.8 MHz or 249.6 MHz pulse repetition frequency (PRF), respectively. 

For automotive industry, global automotive industry organization Car Connectivity Consortium® (CCC) was 

founded in 2011. It standardizes interface to provide consistently great user experiences across light vehicles 

and mobile devices. Through CCC Digital Key standard, it makes widespread adoption of smartphones as 

vehicle keys possible. The latest Digital Key Release 3.0 adds hands-free, location-aware keyless access 

and location-aware features by adopting UWB secure ranging technology based on IEEE 802.15.4z standard 

in combination with standard Bluetooth®Low Energy connectivity [6].  

FiRa® Consortium was founded in 2019 and is an organization dedicated to expand the UWB ecosystem by 

ensuring interoperability between multiple devices through compliance and certification programs. 

In the remaining of this application note, 802.15.4 and 802.15.4z are the respective synonym of IEEE 

802.15.4 and IEEE 802.15.4z standard. 

1.2 UWB Frequencies and Channels 

The UWB channel allocation based on 802.15.4 [4] is summarized in Table 1-1.  

HRP UWB PHY operates 16 channels in three band groups, i.e. subgigahertz (subGHz), low band and high 

band, denoted as band group 0, 1 and 2, respectively. 

Band group Frequency range Channel 
number 

Center frequency 
(MHz) 

Bandwidth 
(MHz) 

Mandatory (M) / 
Optional (O) 

0 (subGHz) 249.6 MHz to 749.6 MHz 0 499.2 499.2 M 

1 (Low band) 3.1 to 4.8 GHz 1 3494.4 499.2 O 

2 3993.6 499.2 O 

3 4492.8 499.2 M 

4 3993.6 1331.2 O 

2 (High band) 6.0-10.6 GHz 5 6489.6 499.2 O 

6 6988.8 499.2 O 

7 6489.6 1081.6 O 

8 7488 499.2 O 

9 7987.2 499.2 M 

10 8486.4 499.2 O 

11 7987.2 1331.2 O 

12 8985.6 499.2 O 

13 9484.8 499.2 O 

14 9984 499.2 O 
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Band group Frequency range Channel 
number 

Center frequency 
(MHz) 

Bandwidth 
(MHz) 

Mandatory (M) / 
Optional (O) 

15 9484.8 1354.97 O 

Table 1-1 HRP UWB PHY channel allocation 

Each channel spans 500 MHz bandwidth except channel 4, 7, 11 and 15. Supporting of channel 0, 3 and 9 is 

mandatory for UWB implementation in the related bands. The majority of the UWB products on the market as 

of today focus on the high band group, operating in channel 5 and 9 particularly. 

For example, NXP Trimension™ NCJ29D5 device operates in high band from 6 GHz to 8.5 GHz.  

1.3 UWB Physical Layer Signal Properties 

1.3.1 UWB Waveform 

A mandatory Root Raised Cosine (RRC) pulse shaping with roll-off factor β = 0.5 has to be applied as a 

reference pulse (see Equation 1-1).  It's impulse response r(t) is as follows: 

𝑟(𝑡) =
4𝛽

𝜋√𝑇𝑝

 

cos[(1 + 𝛽) 𝜋𝑡 𝑇𝑝⁄ ] + 
sin[(1 − 𝛽) 𝜋𝑡 𝑇𝑝⁄ ]

4𝛽𝑡 𝑇𝑝⁄

1 − (4𝛽𝑡 𝑇𝑝⁄ )
2  

 

Equation 1-1 UWB impulse response 

Where Tp is the pulse duration, measured in nanoseconds. 

1.3.2 Frame Structure 

HRP ranging-capable devices (HRP-RDEV) facilitate the ranging function based on physical layer 

implementations in line with 802.15.4 [4]. 

The PHY protocol data unit (PPDU) frame configuration of an HRP-RDEV is composed of the 

synchronization header (SHR), physical layer header (PHR) and physical layer service data unit (PSDU) as 

shown in Figure 1-1 

 

Figure 1-1 PPDU of UWB HRP-RDEV (802.15.4) 
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As a supplement to the 802.15.4 standard, 802.15.4z meets the eve-increasing demands of highly secure 

and precise ranging. The key enhancements are:  

► Inclusion of the scrambled timestamp sequence (STS) field in the HRP PPDU format  

► PRF increment applied for preamble and data field  

Devices supporting these enhancements are called HRP enhanced ranging devices (HRP-ERDEV). Two 

mandatory functions must be supported:  

► Operation in base pulse repetition frequency (BPRF) mode at a nominal PRF of 64 MHz  

► Operation in higher pulse repetition frequency (HPRF) mode at a higher PRF of 124.8 MHz or 249.6 

MHz  

1.3.3 Synchronization Header (SHR) 

Synchronization header (SHR) consists of preamble and start-of-frame delimiter (SFD) 

1.3.3.1 Preamble 

Preamble Code Index 

The preamble portion of the SHR is used for timing synchronization, packet detection, and carrier frequency 

offset recovery. 

Each preamble symbol consists of a predefined preamble code sequence drawn from a ternary alphabet {–

1,0,1}. 802.15.4 [4] specifies mandatory length-31 (mandatory) and optional length-127 preamble code 

sequences. In Table 1-2, the channel dependent length-31 preamble code sequences are listed with an 

individual index (1 to 8).  

Index Code Sequence Ci Channel NumberI 

1 - 0 0 0 0 + 0 - 0 + + + 0 + - 0 0 0 + - + + + 0 0 - + 0 - 0 0 0, 1, 8, 12 

2 0 + 0 + - 0 + 0 + 0 0 0 - + + 0 - + - - - 0 0 + 0 0 + + 0 0 0 0, 1, 8, 12 

3 - + 0 + + 0 0 0 - + - + + 0 0 + + 0 + 0 0 - 0 0 0 0 - 0 + 0 - 2, 5, 9, 13 

4 0 0 0 0 + - 0 0 - 0 0 - + + + + 0 + - + 0 0 0 + 0 - 0 + + 0 - 2, 5, 9, 13 

5 - 0 + - 0 0 + + + - + 0 0 0 - + 0 + + + 0 - 0 + 0 0 0 0 - 0 0 3, 6, 10, 14 

6 + + 0 0 + 0 0 - - - + - 0 + + - 0 0 0 + 0 + 0 - + 0 + 0 0 0 0 3, 6, 10, 14 

7 + 0 0 0 0 + - 0 + 0 + 0 0 + 0 0 0 + 0 + + - - - 0 - + 0 0 - + 4, 7, 11, 15 

8 0 + 0 0 - 0 - 0 + + 0 0 0 0 - - + 0 0 - + 0 + + - + + 0 + 0 0 4, 7, 11, 15 

Table 1-2 Length-31 ternary preamble code sequence [4] 

The use of length-127 ternary preamble code sequences is optional. In total, 16 length-127 ternary 

sequences indexed from 9 to 24 are specified. Similar to length-31 preamble code sequence, the applicable 

preamble index is also channel dependent. The complete length-127 preamble code sequence can be 

referred in Table 15-7 of 802.15.4 [4]. 

For HRP-ERDEV, it is mandatory to support length-91 ternary preamble code sequences in addition which 

has code index ranged between 25 and 32. Unlike length-31 and length-127, the selection of length-91 code 

index is not bounded to channel. Complete length-91 preamble code sequence is listed in Table 15-7a of 

802.15.4z [5]. 

Preamble Length 

                                                      

 

I Code index 1 to 6 may also be used for HRP UWB channel 4, 7, 11, 15 (channel bandwidth > 500 MHz) if inter-channel communication is 
desired. 
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The preamble code is spread to construct a preamble symbol, and the resultant preamble symbol is then 

repeated to constitute the SYNC field portion of the SHR as shown in the example in Figure 1-2. The SYNC 

field contains simple repetitions of the preamble symbol and the number of preamble symbol repetitions are 

16, 64, 1024 and 4096 as defined in 802.15.4 [4]. In HPRF mode (PRF > 64 MHz), the HRP-ERDEV shall 

support 32 and 64 preamble symbol repetitions with optional values being 16, 24, 48, 96, 128 and 256 as 

defined in 802.15.4z [5]. 

 

Figure 1-2 Construction of a preamble symbol Si by spreading [4] 

Preamble length (16, 32, 64, 1024, 4096) refers to the number of preamble symbol repetitions. 

1.3.3.2 Start of Frame Delimiter (SFD) 

The SFD signals the end of the preamble and start of the PHY header (PHR). 

SFD Type 

SFD supports mandatory 8 symbols (short) and optional 64 symbols (long) as shown in Table 1-3, depending 

on the subsequent transmitted data rate for HRP-RDEV [4]. 

SFD Length Applicability Support 

 64 symbols (Long) For low data rate (110kbps) Optional 

 8 symbols (Short) For other data rates Mandatory 

Table 1-3 SFD sequence of HRP-RDEV (802.15.4) 

The SFD type for HRP-ERDEV is given in Table 1-4 [5]. 

SFD Type SFD Length Mode Support 

0 8II BPRF Mandatory 

1 4 HPRF Mandatory 

2 8 BPRF / HPRF Mandatory 

                                                      

 

II Equivalent to short SFD sequence (8 symbol length) of HRP-RDEV (802.15.4) (cf. Table 1-3)  
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SFD Type SFD Length Mode Support 

3 16 HPRF Mandatory 

4 32 HPRF Optional 

Table 1-4 SFD sequence for HRP-ERDEV (802.15.4z) 

1.3.4 PHY Header (PHR) and PHY Service Data Unit (PSDU) 

As per specification [4] [5], data rate of PHR and PSDU are predefined depending on the PHR data rate 

mode in use. Refer to Table 1-5 for HRP-RDEV, Table 1-6 and Table 1-7 for HRP-ERDEV to know the 

corresponding PHR bit rate and associated PSDU bit rate. 

PHR Data Rate Mode PHR Bit Rate (Mb/s)  PSDU Bit Rate (Mb/s)  

DRMDR 0.85 or 0.11 0.11 / 0.85 / 6.8 / 27.2 

Table 1-5 PHR and PSDU data rate in HRP-RDEV (802.15.4) 

PHR Data Rate Mode PHR Bit Rate (Mb/s)  PSDU Bit Rate (Mb/s)  

DRBM_LP 0.85 6.8 

DRBM_HP 6.8 6.8 

Table 1-6 PHR and PSDU data rate in HRP-ERDEV BPRF mode (802.15.4z) 

PHR Data Rate Mode Viterbi Constraint Length PHR Bit Rate (Mb/s) PSDU Bit Rate (Mb/s) Mean PRF (MHz) 

DRHM_LR CL3 3.9 6.8 124.8 

DRHM_LR CL7 7.8 7.8 124.8 

DRHM_HR CL3 15.6 27.2 249.6 

DRHM_HR CL7 31.2 31.2 249.6 

Table 1-7 PHR and PSDU data rate in HRP-ERDEV HPRF mode (802.15.4z) 

1.3.5 Scrambled Timestamp Sequence (STS) 

802.15.4z [5] introduced a new frame structure by incorporating a scrambled timestamp sequence (STS) to 

enhance the data integrity which is basically a cryptographically generated sequence of pulses using the 

AES-128 algorithm that is then added to the HRP UWB PHY frame structure.  

STS Packet Structure (0, 1, 2, 3) 

Depending on the position of STS portion in the frame, four STS packet structures are defined (see Figure 

1-3). In each STS packet configuration, the RMARKER plays the same role as it does for legacy RDEV, i.e. it 

serves as a reference point for frame timestamping. 

 

Figure 1-3 Scrambled Timestamp Sequence (STS) packet configurations 

Please be noted, SP3 does not contain PHR and PSDU. Therefore, if measurements on data part are 

required, then SP3 should be avoided. 

The generation of the STS is illustrated below in Figure 1-4. 
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Figure 1-4 STS generation (by spread length 4, HPRF) 

STS parameters associated with each HRP-ERDEV mode are given in Table 1-8.  

HRP-ERDEV Mode Spread Length L Pulse Spacing 
(Chips) 

Mean PRF (MHz) STS Length in Unit of 
512 chips 

Number of 
Supported Segment 

BPRF 8 8 62.4 64 1 

HPRF  4 4 124.8 32, 64, 128, 16III, 256III 1, 2, 3III, 4III 

Table 1-8 STS parameters 

STS Index 

Index of the STS for waveform generation, it can be any integer between 0 and 232 

STS Length 

STS length refers to the length of each STS segment in unit of 512 chips. It varies between 16, 32, 64, 128 

and 256 as given in Table 1-8. 

STS Segment Count 

STS segment count specifies the total number of the segments in STS field. For HPRF, it can support up to 4 

segments (refer to Table 1-8). 

1.4 Time of Flight (ToF) 

UWB technology adopts ToF method for distance ranging. ToF is basically the signal's traveling time in free 

space between the initiator (Tag) and responder (Anchor). Its estimation is based on the reliable and robust 

ranging timestamp.  

Two-way ranging (TWR) is a common method to measure the distance between two UWB devices 

particularly when clock synchronization between them is absent. In other words, each device uses its own 

clock reference to perform the measurements independently. By knowing the ToF between the two devices, 

the distance can be easily calculated as the ToF multiplied by the speed of light. 

There are two different TWR flavors described in the subsequent sections, single-sided two-way ranging (SS-

TWR) and double-sided two-way ranging (DS-TWR). With the amendment in [5], the ranging capability is 

                                                      

 

III Optional 
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further enhanced to support secure ranging by including STS (see 1.3.5) to prevent distance fraud attacks in 

which an attacker manipulates the distance estimation process.  

1.4.1 Single-sided Two-Way Ranging (SS-TWR) 

 

Figure 1-5 Single-sided two-way ranging 

As depicted in Figure 1-5, device A (Tag) wants to determine its distance to device B (Anchor) by estimating 

the ToF. It sends a poll message in a ranging frame (RFRAME flag is set in PHR) to device B and receives 

the response message returned by device B in the end. RMARKER is defined to be the time when the 

beginning of the first symbol of the PHR of the RFRAME is at the local antenna. It functions like a stopwatch 

to measure the round-trip time of a message.  

Several time differences are measured or calculated. Tprop is the propagation time over the air. The times 

TAround and TBreply are the processing time measured independently by device A and B using their own local 

clock. The measured TBreply is piggy-backed in the response message from device B to A. By knowing TAround 

and TBreply, device A calculates its ToF using formula 𝑇𝑝𝑟𝑜𝑝 =
𝑇𝐴𝑟𝑜𝑢𝑛𝑑−𝑇𝐵𝑟𝑒𝑝𝑙𝑦

2
. The distance equals to 

𝑐𝐴𝐼𝑅 × 𝑇𝑝𝑟𝑜𝑝 where 𝑐𝐴𝐼𝑅  is the speed of light, i.e. 29.97 cm/ns  

SS-TWR does not require a synchronized clock on both transmitter and receiver side. But, in reality, due to 

the clock jitter or clock offset error on both sides caused by the imperfection of the clock oscillator, the ToF 

estimation error is caused. The reply time TBreply is the dominant factor of the distance estimation error in SS-

TWR method.  

In this document, we focus on SS-TWR. 

1.4.2 Double-sided Two-Way Ranging (DS-TWR)  

Like SS-TWR, DS-TWR is an asymmetrical ranging method, meaning no need for response times on both 

devices to be the same. It is a combination of two SS-TWR procedures that differs in the direction of the 

initiation.  
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Figure 1-6 Double-sided two-way ranging 

The principle of DS-TWR is illustrated in Figure 1-6. The whole procedure is initiated by device A (Tag) 

towards device B (Anchor). Device B then sends response to device A, and in the same way, device B 

initiates second round SS-TWR towards device A. The whole procedure is completed after device B receives 

the response from device A. Usually, the poll message and response message from device B towards device 

A can be combined into one message. Therefore, DS-TWR involves practically three messages in total.  

The resultant ToF estimation 𝑇𝑝𝑟𝑜𝑝 =
𝑇𝐴𝑟𝑜𝑢𝑛𝑑 × 𝑇𝐵𝑟𝑜𝑢𝑛𝑑 − 𝑇𝐴𝑟𝑒𝑝𝑙𝑦 × 𝑇𝐵𝑟𝑒𝑝𝑙𝑦

𝑇𝐴𝑟𝑜𝑢𝑛𝑑+ 𝑇𝐵𝑟𝑜𝑢𝑛𝑑+ 𝑇𝐴𝑟𝑒𝑝𝑙𝑦+ 𝑇𝐵𝑟𝑒𝑝𝑙𝑦
   

By knowing the ToF estimation 𝑇𝑝𝑟𝑜𝑝, the distance can then be calculated according to the same principle as 

in the SS-TWR case, i.e. estimated ToF is multiplied by the speed of light to determine the distance. 

Compare to SS-TWR, the impact of clock offset on the ToF estimation is significantly reduced. The 

estimation error in DS-TWR solely depends on the ToF, but not on TBreply as in SS-TWR the case [7].  

2 OTA Basics 

2.1.1 Far Field 

The electromagnetic wave propagation and radiation around an antenna can be classified into three regions, 

i.e. reactive near field, radiative near field and far field (FF) as illustrated in Figure 2-1. 

 

Figure 2-1 Wave propagation regions around an antenna (source: wikipedia) 

Basically, in OTA test environment, far field is of high importance. Because in that region the electromagnetic 

wave is assumed to have predominantly plane wave character. Measurements conducted in FF provides 

higher measurement reliability. The minimum distance at which FF is assumed is a so-called Fraunhofer 

distance (FHD) 𝑟𝐹𝑟  . It is denoted as  
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𝑟𝐹𝑟 =
2𝐷2

𝜆
 

Equation 2-1 Fraunhofer distance 

where D stands for the radiating aperture size of the antenna, λ is the wavelength of the carrier frequency. 

FHD is necessary to be respected if the whole antenna pattern is concerned. However, if only the main lobe 

of the antenna transmission pattern is considered which is the case for UWB applications here, then the FHD 

can be relaxed by Derat distance 𝑟𝐷𝑒 as given in Equation 2-2. 

𝑟𝐷𝑒 = 𝜆 (
𝜋𝐷

𝜆
)

0.8633

[0.1673 (
𝜋𝐷

𝜆
)

0.8633

+ 0.1632] 

Equation 2-2 Derat distance 

With this consideration, the footprint of the OTA chamber can be reduced, yet without having negative impact 

on the measurement performance [8]. 

The OTA solution described in this document utilizes Vivaldi antenna shown in Figure 3-8 as 

measurement/feed antenna. A study on the FHD and Derat distance of UWB channel 5 and 9 by utilizing 

Vivaldi antenna with 70 mm antenna aperture is given in Table 2-1. It shows that FF distance is reduced 

significantly by considering the Derat distance 𝑟𝐷𝑒. 

 𝒓𝑭𝒓 (mm) 𝒓𝑫𝒆 (mm) 

UWB Channel 5 (6.4896) GHz ~210 ~140 

UWB Channel 9 (7.9872) GHz ~260 ~160 

Table 2-1 Comparison of 𝑟𝐹𝑟 vs. 𝑟𝐷𝑒 of a Vivaldi antenna radiating at UWB channel 5 and 9 

Distance between Vivaldi antenna and DUT antenna should be no less than Derat distance 𝑟𝐷𝑒 in order to 

ensure that the FF condition is met in the downlink direction, i.e. from tester to DUT. This condition is 

particularly recommended to be fulfilled for an Angle of Arrival (AoA) test scenario where phase deviation 

should be kept at a lower level. 

2.1.2 Quiet Zone (QZ) 

A quiet zone D defines the area in which deviation of the amplitude and phase from the plane wave criteria is 

limited [9]. At the FHD, the amplitude difference is negligible over the surface D with a phase deviation Δφ of 

up to 22.5° [10]. Figure 2-2 illustrates the determination of a quiet zone size. 

 

Figure 2-2 Determination of quiet zone size 

Quiet zone size limits the maximum size of the tested DUT size (or DUT antenna size in case white box 

approach) and reflects the size of the chamber as well. The bigger the quiet zone is, the larger the chamber 

size has to be. As a result, a DUT with larger antenna size can be tested.  

As we already know from the previous section, as long as the DUT antenna is at least in Derat distance 𝑟𝐷𝑒 to 

Vivaldi antenna, then we are testing in QZ in downlink direction. 

Whereas in the opposite direction (uplink), from DUT perspective, assuming white-box approach is adopted 

(details see 2.1.3), given the DUT antenna size and carrier frequency, we can derive Derat distance 𝒓𝑫𝒆. If 
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the derived 𝒓𝑫𝒆 does not exceed the chamber size (max 300mm for CMQ200/CMQ500), then uplink testing 

in QZ is also guaranteed.  

2.1.3 White-box and Black-box Approach 

Testing in OTA environment has basically two approaches, namely, white-box and block-box approach. 

The white-box approach is suitable in the case where the antenna position of the DUT is known exactly. This 

approach can be typically adopted by R&D and production application.  

Whereas for black-box approach, the position of the DUT antenna is unknown. Therefore, up to the 

maximum DUT dimension has to be considered for the determination of the FHD or Derat distance which in 

turn requires larger chamber size. The black-box approach has a significant importance for the DUT 

conformance testing or testing at service stage. 

In compare to black-box approach, white-box approach leads to small floor space of the OTA chamber. Since 

the DUT used for testing in this application note is based on NXP chipset with prior knowledge of the antenna 

position, white-box approach is the focus of this document. 

3 UWB OTA Test Solution 

3.1 System Overview and Preparations 

UWB OTA test solution with shielding chamber CMQ200 HS is shown in Figure 3-1. Alternatively, the 

shielding chamber CMQ500 can be facilitated for UWB testing as well. 

 

Figure 3-1 R&S UWB Over the Air test setup with CMQ200 HS 

In this document, two setup variants (system variant 1 and variant 2) are addressed that differ in the number 

of the mounted Vivaldi antenna in the shielding chamber and the associated RF connection to the chamber.  

The setup block diagram (system variant 1) shown in Figure 3-2 is equipped with a single Vivaldi 

measurement antenna in the chamber which is connected with an RF feedthrough. This setup can well cover 

UWB Tx, Rx and ToF measurements. 
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Figure 3-2 Block diagram of system variant 1: UWB OTA testing environment with RF feedthrough for Tx, Rx and ToF measurement 

(single Vivaldi antenna) 

For ease of verifying the AoA from different impingement angle, test solution with multiple Vivaldi antennas is 

recommended. To allow the RF path switching, an RF switch (R&S SP6T) has to be adopted here as 

illustrated in Figure 3-3 (system variant 2). 

 

Figure 3-3 Block diagram of system variant 2: UWB OTA testing environment with RF switch for Tx, Rx, ToF and AoA measurement 

(multiple Vivaldi antennas) 

3.1.1 Hardware Requirements 

Hardware requirements of the solution include: 

► Device Under Test (see 3.1.1.1) 

► Radio Communication Tester CMP200 (see 3.1.1.2 ) 

► UWB ToF Kit R&S CM-Z300A (see 3.1.1.3) 

► Shielding chamber CMQ500 or CMQ200 with High Shielding (HS) option (see 3.1.1.4) 

► Linear polarized Vivaldi antenna CMQ-725A (Antenna kit 5, UWB) (see 3.1.1.5) 
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► RF connection kit: RF switch CMQ-B744A or RF feedthrough CMQ-B742A (see 3.1.1.6) 

► Control PC (a PC with Microsoft Windows® OS) 

3.1.1.1 Device Under Test (DUT) 

In this document, following NXP evaluation boards are used for testing: 

► For UWB Tx, Rx and ToF testing, NXP Trimension™ NCJ29D5 Evaluation Board for Automotive Ultra-

Wideband [11] (Figure 3-4).  

 

Figure 3-4 NXP Trimension™ NCJ29D5 evaluation board 

UWB tests conducted in this application note are based on the DUT version information as given in Table 3-1 

below. 

UCI Version UCI CCC Version CCC Version Firmware Version Device Version 

1.0 1.5 0.2.6 2.0.0 22.0 

Table 3-1 DUT's version information 

► AoA measurements shall be possible with the next generation NXP Trimension™ NCJ29D6 chipset. 

This chipset is under development at the release time of this document. 

3.1.1.2 Radio Communication Tester CMP200 

 

Figure 3-5 R&S CMP200 with multiple switchable ports 

CMP200 is a one-box mobile radio tester (MRT) suitable for UWB and 5G FR2 testing in non-signaling mode. 

It contains general purpose analyzer covering frequency range from 6 to 20 GHz and ARB generator. It 

supports replay of predefined waveforms ( -100 dBm) with frequency range from 6 to 20 GHz. Three 

switchable ports with 1 GHz bandwidth each accelerate the measurement speeds. 

Follow the Link here for further reading. 

3.1.1.3 UWB ToF Kit R&S CM-Z300A 

UWB Time of Flight (ToF) Kit CM-Z300A is a collection of accessories that provides a fixed group delay (GD) 

and insertion loss (IL) over the signal path. This is important for the antenna delay calibration as well as the 

pathloss calibration of the system. See 3.3.1 and 3.3.2.3 for more detailed information. 

https://www.rohde-schwarz.com/us/products/test-and-measurement/wireless-tester-rf-analyzer-generator/rs-cmp200-radio-communication-tester_63493-601281.html
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ToF Kit Z300A (Figure 3-6) contains: 

► Power splitter (Model: Minicircuit ZFRSC-183+) (cf. data sheet in Appendix A) 

► Attenuator (6 dB, 10 dB, 20 dB, 30 dB) 

► RF cables (2 x 2 m) 

► RF cable (1 x 15 cm) 

 

Figure 3-6 UWB ToF kit CM-Z300A 

The attenuator (6 dB, 10 dB, 20 dB or 30 dB) in the ToF kit can be optionally inserted in the signal path so 

that the receive power level at CMP200 IFin port can be varied. This is sometimes required for stable signal 

detection. More details about the power level adjustment for ToF testing is given in Appendix D. 

3.1.1.4 Shielding Chamber 

CMQ200 HS or CMQ500 are ideal shielding chambers for UWB OTA testing featuring 

► Operating frequency range CMQ200 HS 0.3 to 14 GHz / CMQ500 0.7 to 77 GHz  

► High shielding effectiveness > 80 dB 

► Perfectly suited for multi-antenna setups required for instance for UWB AoA measurements 
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Figure 3-7 Front and rear view of OTA chamber CMQ200 HS (upper) and CMQ500 (lower)  

In general, OTA shielding chamber can be flexibly configured according to customer's testing needs, e.g. 

door open-close mechanism, table layouts, fixture layouts, feedthroughs (RF, USB, other connections) etc. 

For more details about the chamber configurations, please refer to [12] or contact your local R&S 

representative. 

In this document, the used DUT in the chamber is powered and controlled by USB. Therefore, an USB 

feedthrough is a must-to-have accessory to be used here. Besides that, either RF feedthrough or RF switch 

(see 3.1.1.6) needs to be equipped. 

Further readings on R&S website: CMQ200 product page and CMQ500 product page. 

3.1.1.5 Antenna Kit 

The antenna kit (CMQ-B725A) contains standardized components for UWB testing in OTA chamber. It 

eliminates the measurement uncertainties caused by the unequal length of RF cables that are in use. It 

includes the antenna that covers the required frequency range for UWB measurements.  

Included components are: 

► Vivaldi antenna 

single linear broadband ultra-wideband antenna with a directive pattern and high gain that covers the 

frequency range from 2.4 to 18 GHz. Figure 3-8 shows Vivaldi antenna with open aperture size of 70 

mm. 

 

Figure 3-8 R&S TS-F24-V2 (Vivaldi Antenna) with 70 mm aperture size 

► 55 cm RF cable which interconnects the Vivaldi antenna with the RF switch or RF feedthrough of the 

OTA chamber 

► Vivaldi antenna fixation accessories: 3D fixture and 45° adapter 

https://www.rohde-schwarz.com/us/products/test-and-measurement/antenna-test-systems-and-ota-chambers/rs-cmq200-shielding-cube_63493-683264.html
https://www.rohde-schwarz.com/us/products/test-and-measurement/antenna-test-systems-and-ota-chambers/rs-cmq500-shielding-cube_63493-807406.html
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3.1.1.6 RF Connection Kit 

Two RF connection kits (either RF feedthrough or RF switch) can be chosen. Both RF connection kits cover 

the frequency range up to 40 GHz.  

Single Vivaldi antenna is connected through an RF feedthrough (CMQ-B742A) in the chamber (system 

variant 1). 

The optional RF switch RS SP6T (CMQ-B744A) (see Figure 3-9) is only required when multiple Vivaldi 

antennas need to be installed in the OTA chamber, e.g. for AoA measurement (system variant 2).  

 

Figure 3-9 RF switch module SP6T 

RF switch RS SP6T possesses 6 switch ports. Its port numbering from front view is highlighted in Figure 

3-10.  

 

Figure 3-10 RF Switch (SP6T) port numbering from front view 

In multi-antenna setup, the changing of RF switch position is controlled via remote interface of CMQ which is 

fully integrated in the WMT software. This is only possible when the connection of RF switch port and Vivaldi 

antenna is properly configured in the test configuration testconfig.ini file.  

In Figure 3-11, a configuration example is given. Three Vivaldi antennas are connected to RF switch that is 

then connected to Port1.IFin port of CMP200. In this constellation, the last digit of mnemonic 'relay' in 

testconfig.ini file reveals the RF switch port number with which the Vivaldi antenna is connected. 

Figure 3-12 is the configuration in testconfig.ini file that the Vivaldi antenna #1 (the one in the middle) 

can be applied.  

1 2 

3 

4 5 

6 
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Figure 3-11 RF switch port number configuration 

 

Figure 3-12 Relay configuration in testconfig.ini 

Details of testconfig.ini file can be referred in Appendix C. 

3.1.2 Software Requirements 

This chapter outlines the software requirements of the test solution. 

3.1.2.1 CMP200 Firmware 

3.1.2.1.1 General 

CMP200 firmware is required to be installed on CMP200. It is responsible for the signal generation and 

analysis, allows remote access of the instrument via Web-based GUI CMsquares. In terms of the licenses, 

please make sure following licenses are in place for UWB testing: 

► UWB measurement option KM300 

► WinIQSIM2 option KW300 for ARB generation (waveform file generation) 

► Smart channel software option CMP-K103 enables 3 DUT parallel testing to speed up the testing time 

(optional) 

Connection identifier 

Connector Name on CMP200 

Relay position (last digit corresponds the RF switch port) 

number) 
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In Figure 3-13, it represents the UWB measurements in CMsquaresIV of the CMP200. CMsquares is 

accessible from any PC by entering the IP address of the CMP200 in the address field of a Web browser 

given that both PC and CMP200 are on the same IP subnet (see IP settings in 3.1.4). 

 

Figure 3-13 UWB measurements in CMsquares on CMP200 

3.1.2.1.2 Installation 

Check in the GlorisV (https://gloris.rohde-schwarz.com/) and make sure that the latest software is installed on 

the CMP200. If not, please proceed the following steps to update the software. 

1. Download the CMP200 software installer (setup_cmp200_xyzVI.exe) from Gloris to the control PC 

2. Execute the installer remotely on control PC and follow the steps below 

a) Double click on the installer will launch the software distributor. From there, select 'Remote 

Installation' and press 'Next' to proceed (Figure 3-14). This will allow the software to be installed on 

CMP200 remotely. 

                                                      

 

IV CMsquares denotes the web-based graphic user interface (GUI) of the CMP200  
V Gloris represents a self-service customer portal of R&S  
VI xyz is a placeholder for CMP200 software version 

https://gloris.rohde-schwarz.com/
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Figure 3-14 Launch software distributor 

b) Accept the license agreement and press 'Next' to proceed (Figure 3-15) 

 

Figure 3-15 Accept the license agreement 

c) Select all the packages to install and press 'Next' to proceed (Figure 3-16). 

 

Figure 3-16 Select the packages to install 

d) Choose the CMP200 unit in the 'Device List' where the software is going to be installed remotely 

and press 'Install' to start the installation process (Figure 3-17). 



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  24 

 

  

 

Figure 3-17 Select the CMP200 unit 

e) Wait few minutes until text 'Ready: see report for details' appears in 'Status' column. Click 'Report' 

to make sure that the installation is successful. 

f) Click 'Exit' to exit the software distributor. 

g) Reboot CMP200.  

h) After CMP200 start-up and firmware update process is completed, enter the IP address of the 

CMP200 in the control PC browser (IP configuration of the setup, see 3.1.4), CMP200 GUI 

(CMsquares) will be loaded (Figure 3-18). 

 

Figure 3-18 Load CMsquares 

3.1.2.2 WinIQSIM 

3.1.2.2.1 General 

WinIQSIM is a Windows based signal generation software that creates digitally modulated signal waveforms 

including UWB waveform. The generated waveform files contain the same test signal settings for repeatable 

tests.  

In our application here, WinIQSIM generates the UWB test signal in a form of waveform file for the UWB 

receiver test on control PC. The waveform file is then transferred and played back on the CMP200. 
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Figure 3-19 shows the WinIQSIM main GUI window. 

 

Figure 3-19 WinIQSIM main GUI window 

3.1.2.2.2 Installation 

1. Visit https://www.rohde-schwarz.com/us/software/winiqsim2/ to get the latest WinIQSIM software and 

install it on control PC. The software is distributed as a windows installer. 

2. Launch the WinIQSIM software and let it run in the background (WMT will take control of WinIQSIM). 

This is only required when a new waveform file has to be generated. If the required waveform file 

already exists on CMP200, then WinIQSIM will not be needed, hence, it is not required to have it run in 

the background. 

3.1.2.3 Wireless Automated Testing (WMT) Tool 

3.1.2.3.1 General 

WMT is a Python based software solution for chipset and module RF testing of 5G NR, Wi-Fi, Bluetooth and 

UWB (including UWB Tx, Rx, ToF and AoA testing) etc. It is tailored for high volume production testing and 

R&D applications. A modular architecture enables the flexible integration and minimizes time-to-market of a 

product. 

https://www.rohde-schwarz.com/us/software/winiqsim2/
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Figure 3-20 WMT Architecture 

As illustrated in Figure 3-20, WMT is installed on control PC featuring instrument control (e.g. CMP200), 

communicating with OTA chamber (e.g. CMQ200/CMQ500), DUT control (UCI communication with UWB 

DUT), testcase execution, limit check and report collection. 

The controlling part herein contains following functionalities: 

► Controlling the CMP200 through the SCPI remote interface using a TCP/IP raw socket connection 

► For CMQ200/CMQ500 chamber, setting RF switch position is required to select the different used 

measurement antennas in multiple antenna case, e.g. for AoA testing. This is controlled through the 

remote interface using a TCP/IP raw socket connection 

► Controlling the DUT using standard FiRa or NXP proprietary UCI command communication through the 

control interface (COM port) 

Two GUIs are provided by WMT, namely, WMT Test Plan Editor and WMT Test Runner. In the following text, 

we use Test Plan Editor and Test Runner as the synonym of WMT Test Plan Editor and WMT Test Runner, 

respectively. 

In Test Plan Editor (Figure 3-21), as the name already implied, a test plan can be newly created or the 

existing one can be modified. In each test plan, it is possible to include multiple test routines with individual 

parameter settings (see 3.3 and 3.4 for more details). 

 

Figure 3-21 WMT Test Plan Editor GUI 
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Test Runner (Figure 3-22) provides the environment for test execution of a selected test plan as well as 

multi-DUT parallel testing. After each test plan is executed, test report can be inspected. Debug log 

associated to the test run can be checked in Test Runner, if required. 

 

Figure 3-22 WMT Test Runner GUI 

Follow the link here for further reading. 

3.1.2.3.2 Installation 

Distribution of the WMT software is in form of a windows installer, e.g. for NXP Trimension™ NCJ29D5 chip, 

execute the installer NXP_NCJ29D5D_UCI_Custom-Custom.1.0.0.7.msi and go through the installation 

steps as follows: 

1. Confirm the welcome page by pressing 'Next' button  

 

Figure 3-23 Welcome page 

2. Confirm the license agreement by pressing 'Next' button 

https://www.rohde-schwarz.com/us/products/test-and-measurement/wireless-communications-testers-systems/wireless-communication-testers-systems/wireless-manufacturing-test_253261.html
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Figure 3-24 Accept license agreement 

3. Specify an installation folder on the control PC and press 'Next' key to proceed 

 

Figure 3-25 Specify the destination folder 

4. Press 'Install' button to start the installation 

 

Figure 3-26 Confirm installation 

5. Wait until the installation process is completed, then press 'Finish' button to exit 
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Figure 3-27 Completion of the installation 

After successful installation, the folder structure under the WMT installation folder is created (see Figure 

3-28). From there, Test Plan Editor (testplan_editor.exe) and Test Runner (testrunner_gui.exe) 

can be called. Create sub-folder 'testplans' under the installation folder to place test plans if it does not exist. 

  

Figure 3-28 Folder structure under the installation folder 

3.1.2.4 DUT USB Driver 

For Evaluation board NXP Trimension™ NCJ29D5, an USB driver needs to be installed on control PC. Visit 

https://www.pemicro.com/opensda/ to obtain USB driver installer (PEDrivers_install.exe). 

3.1.3 Cabling 

System cablings on the test setup are shown below in Figure 3-29, Figure 3-30 and Figure 3-31. 

https://www.pemicro.com/opensda/
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Figure 3-29 Front view of setup with cabling  

RF Cables of UWB ToF Kit  

USB cable for DUT power 

supply and UCI command  

USB feedthrough 

Control PC 

CMP200 

CMQ500 
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Figure 3-30 Rear view of setup with cabling 

     

Figure 3-31 Cabling of power splitter and its connections to RF ports of CMP200 

RF switch 

RS232 cable 

(RF switch  R1 port of CMQ)  

LAN cable chamber 

LAN cable CMP200 

Power splitter of 

UWB ToF Kit 

15 cm RF cable of  

UWB ToF Kit 

RF cables of 

UWB ToF Kit 

Port S  RF switch/feedthrough 

Port 1  CMP IF Out 

Port 

OutRswitch/feedthrough 

Port 1  CMP IFout Port 

OutRswitch/feedthrough 

Port 2  CMP IF In 

Port 

OutRswitch/feedthro

ugh 

Port 2  CMP IFin Port 

OutRswitch/feedthrough 



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  32 

 

  

3.1.4 IP Configuration 

CMP200 and control PC should possess the IP address in the same IP segment. This can be done either 

through automatic IP assignment through DHCP or static IP assignment. 

► Automatic IP address assignment via DHCP 

Both CMP200 and control PC are connected via LAN to the network where DHCP server is presented for 

assigning the IP address to each connected device automatically. This is normally the case when CMP200 

and control PC are connected to company network. 

The CMQ200/CMQ500 chamber has however a fixed IP address 192.168.178.41. Most probably, the IP 

address of the control PC and CMP200 will have the different IP subnet assignment by DHCP server, e.g. on 

subnet 10.202.1.*. In this deployment scenario, since control PC needs to be operated on both networks to 

have functional control of CMP200 and chamber, two network interfaces are required on control PC as 

shown in Figure 3-32. 

 

Figure 3-32 Two network interfaces on control PC when IP of CMP200 and control PC are assigned automatically by DHCP server 

► Manual IP address configuration (static IP) 

Set the static IP address on both CMP200 and control PC. This is usually the case for standalone operation 

of the setup. 

Unlike in the automatic case described above, for manual IP address configuration, user can simply 

configure the control PC and CMP200 IP address in such a way that both of them are allocated in the same 

subnet as the fix IP of the chamber, i.e. 192.158.178.*. With that, one network interface on control PC is 

sufficient. 

Further read in Chapter 6.8.1 of [13] to get more detailed instruction especially on the manual IP settings on 

CMP200.  

Hint: 

The CMP200 IP address can be read out directly in LED display on the instrument front panel after the 

successful reboot. 

3.1.5 DUT Positioning in CMQ200/CMQ500 

As mentioned earlier in 2.1.3, we focus on white-box approach in the OTA chamber in this document 

assuming the physical location of the DUT antenna is known. 

For the measurements in OTA chamber, it is crucial to know the free space distance between the Vivaldi 

measurement antenna and DUT's antenna. The distance hat influence on the signal pathloss and signal 

propagation delay (see more details about the calibration in 3.3).  
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CMQ200/CMQ500 offers one of the two table layouts, inner or drawer table layout as listed in Table 3-2. The 

type of the table layout is part of the chamber configuration when the order is placed. 

Table Layout Option Description Remark 

Inner table layout R&S®CMQ-B701A Table is mounted inside of the 
CMQ  

User-defined table height 
position is possible 

Drawer table layout R&S®CMQ-B702A Table is mounted on front drawer 
of CMQ 

Two fixed mounting positions  

Table 3-2 Table layouts of CMQ 

For drawer table layout (see Figure 3-33), one of the two fixed mounting positions (lower position 1 and 

upper position 2) can be chosen to place the table. The two positions are 135 mm apart. Moreover, if the 

Vivaldi antenna is mounted in the chamber with the ordered antenna fixation accessories from R&S (see 

antenna kit 3.1.1.5), then the distance between drawer table position 1 and Vivaldi antenna has a fixed 313 

mm (see Figure 3-34). These reference values can be used later on to determine the free space distance 

between Vivaldi antenna and DUT. 

Since the table is attached to the door, it is convenient for DUT loading/unloading. This brings advantages in 

the production application for instance when robotic arm is adopted.  

 

Figure 3-33 Two fixed positions in CMQ200/CMQ500 chamber with drawer table layout 

 

Figure 3-34 Distance between drawer table position 1 and Vivaldi antenna (313 mm) 

While with inner table layout, the table can be mounted at any height position in the chamber. This offers of 

course more freedom of DUT position. 

Independent of the table layout selected, the free space distance needs to be determined. It is the distance 

between the aperture of the Vivaldi measurement antenna and DUT's antenna. With the help of the cradle 



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  34 

 

  

(fixing frame with scaler) in the CMQ200/CMQ500, the Vivaldi measurement antennas and DUT antenna can 

be aligned on the same plane in y-axis. The free space distance in x-axis is determined with the help of the 

cradle and by taking DUT's antenna geometric situation into account. The minimum distance between the 

DUT and aperture of the Vivaldi antenna on the x-axis needs to fulfil at least the Derat distance as given in 

Table 2-1. For example, for testing channel 5, it should have minimum 14 cm apart. 

Figure 3-35 (inner table layout) shows recommended DUT position and three Vivaldi antenna positions in the 

chamber for all UWB tests, including AoA testing. The impinging angle of the Vivaldi antenna opposed to the 

DUT antenna can be adjusted in 22.5° step size with the help of the antenna adaptor. The example shown in 

Figure 3-36 has the antenna fixed at 45° on the antenna adaptor. 

 

Figure 3-35 Positioning of UWB DUT and measurement antennas (Vivaldi) in a CMQ200 chamber for UWB AoA testing 

Vivaldi Ant2: -45° Vivaldi Ant3: +45° 

Vivaldi Ant1: 0° 

DUT Antenna 

Y 

 

X 
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Figure 3-36 Angle adjustment of the Vivaldi antenna with the adaptor (45°) 

3.2 Test Procedures 

3.2.1 Operations in WMT Test Plan Editor 

Create new UWB test plan or configure an existing one in Test Plan Editor. 

1. In WMT installation folder, double click on 'testplan_editor.exe' to launch Test Plan Editor 

2. In Test Plan Editor, new test plan can be created (main menu > File > New…) or the existing test plan 

can be inspected or modified if desired (main menu > File > Open…). See Figure 3-37. 

The test plan can include test routines for transmitter, receiver, ToF tests. 

  

Figure 3-37 Create a new test plan / Open an existing test plan in Test Plan Editor 

An example test plan is shown in Figure 3-38 below. Further details about the creation of calibration and 

verification routine together with its configurations can be referred further in chapter 3.3.2 and 3.4, 

respectively. 

45° 

 

90° 

 

0° 
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Figure 3-38 An example UWB test plan in Test Plan Editor 

3.2.2 Operations in WMT Test Runner 

Follow the steps below to execute a test plan in Test Runner: 

1. In WMT installation folder, double click on 'testrunner_gui.exe' to launch Test Runner GUI 

2. In Test Runner GUI, a test configuration file (testconfig.ini) should be made available. As shown in 

Figure 3-39, it is accessible from Test Runner main menu> Edit > Settings, there are three operation 

options available: 

─ Edit: edit a test configuration file in a text editor 

─ Open: open an existing test configuration file under the sub-folder \etc in WMT installation folder  

─ New: create a new test configuration file with pre-defined configuration structure 

 

 Figure 3-39 Access to test configuration file 'testconfig.ini' in Test Runner 

3. Configure the 'testconfig.ini' file. Figure 3-40 shows the most important settings to be went 

through 

─ activate a test plan (only one test plan is allowed to be activated at a time, the activation is done by 

removing the semi-colon symbol in front of the test plan in question 

─ specify the virtual serial port on your control PC for DUT control (for UCI communication), e.g. 

COM3 

─ enter the IP address of the CMP200 

1 2 

3 
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─ enable ARB generator, if it is required 

─ define the connection (name, physical connector on CMP200 and the FDCVII of the associated 

connection) 

 

Figure 3-40 Most important settings in 'testconfig.ini' file 

Some hints on the configurations in Figure 3-40 

─ The DUT control port (virtual serial port) entered in the 'testconfig.ini' file can be checked in 

Device Manager of the Windows OS. As example shown in Figure 3-41 indicates that COM3 port is 

assigned. 

─ IP address of the instrument can be easily read out from the LED display located on CMP200's 

front panel 

                                                      

 

VII FDC = Frequency Dependent Correction 

 

Active test plan 

DUT control port for verification 

DUT control port for calibration 

IP address of CMP200 

Enable WinIQSIM to create waveform files 

Name of the connection 

Name of the physical connector on CMP200 

Name of the FDC for this connection 

connector on CMP200 
Name of FDC 

Frequency and Pathloss 



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  38 

 

  

 

Figure 3-41 Check assigned DUT control port in Windows Device Manager  

4. Confirm the changes in 'testconfig.ini' by pressing 'Save' button (Figure 3-40) and press 'Save' 

button (Figure 3-39) in the setting window to quit 

5. Click 'Run' button in main window of Test Runner GUI to execute the test plan (see Figure 3-42). The 

progress of the test plan execution is updated in the Test Runner GUI and the actual test results can be 

checked in the 'DUTxVIII' tab of the GUI 

 

Figure 3-42 WMT Test Runner Overview 

6. After the test plan execution is completed, the whole test results are shown in 'DUTx' (see Figure 3-43). 

If desired, activate the check box 'View Log' to check the detailed log (Figure 3-44) which serves quite 

well for debugging purposes. 

                                                      

 

VIII x is a suffix in the DUT identifier. Suffix is increased by 1 when a new DUT instance is added.  
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Figure 3-43 Test Runner result page 

 

Figure 3-44 Test Runner log view 

7. If needed, navigate to sub-folder etc/results/DUTx/ and etc/logs/DUTx/ under the WMT 

installation folder to fetch the saved test result file and logfile 

3.3 Calibrations 

In this chapter, we are going to tackle the calibration from two aspects, OTA test system pathloss calibration 

and device calibration. 
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3.3.1 OTA Test System Pathloss Calibration 

OTA test system pathloss calibration is necessary to ensure accurate measurement through power level 

compensation. This includes the insertion losses (IL) that occur on the involved components throughout the 

signal propagation chain and signal power level loss over the free space in the chamber, a so-called free 

space path loss (FSPL) which is usually the predominant power loss in an OTA system.  

As mentioned earlier in 3.1, two system variants are considered here, a chamber with RF feedthrough 

(variant 1) and with RF switch (variant 2). Figure 3-45 shows that the PL of both setup variants contains the 

fixed IL portion caused by the known components (ToF Kit, RF feedthrough/RF switch and Vivaldi antenna, 

see 3.1.1.3, 3.1.1.5 and 3.1.1.6) and FSPL which is distance and frequency dependent. 

 

Figure 3-45 Sketch of overall pathloss consists of fixed insertion loss on the signal path plus distance and frequency dependent free 

space pathloss  

A lookup table given in Table 3-3 indicates the overall pathloss from CMP200 output port to DUT antenna 

without attenuator from the ToF kit (see 3.1.1.3) in the signal path. If an attenuator is desired to be connected 

in the signal path, then additional pathloss (6, 10, 20 or 30 dB) has to be added on top of the pathloss of the 

lookup table, accordingly. 

OTA setup Frequency Pathloss from CMP output to DUT  with different free space distance  

  5 cm 10 cm 15 cm 20 cm 25 cm 30 cm 

Variant 1 
(RF feedthrough)  

6.5 GHz -30.0 dB -33.6 dB -36.1 dB -38.1 dB -39.8 dB -41.4 dB 

8 GHz -32.1 dB -35.6 dB -38.1 dB -40.1 dB -41.6 dB -42.9 dB 

Variant 2 
(RF switch)  

6.5 GHz -30.2 dB -33.8 dB -36.3 dB -38.3 dB -40.0 dB -41.6 dB 

8 GHz -32.4 dB -35.9 dB -38.4 dB -40.4 dB -41.9 dB    -43.2 dB 

Table 3-3 Overall pathloss between CMP output port and DUT antenna at 6.5 GHz and 8 GHz without attenuator inserted 

With lookup table approach, it is an easy and fast way to obtain the signal pathloss of the system. The overall 

pathloss is determined by OTA setup variant (with RF feedthrough or RF switch), operating frequency and 

free space distance between Vivaldi antenna and DUT antenna. For example, a setup with RF switch, 

operating at 6.5 GHz with 15 cm distance between Vivaldi antenna and DUT should apply -36.3 dB PL.  

The PL value has to be maintained in the test plan configuration file testconfig.ini (more info, see 3.2 or 

Appendix C) prior to the test execution in WMT. Figure 3-46 indicates that 36.3 dBIX PL at 6.5 GHz is 

assigned for both frequency dependent corrections FDC_ANT1_RX and FDC_ANT1_TX. They are the FDCs 

applied to physical connectors Port1.IFOut and Port1.IFIn of the CMP200 which are identified by connector 

name 'ANT1_RX' and 'ANT1_TX', respectively. In Test Plan Editor, only the connector name as an identifier 

has to be configured, e.g. ANT1_RX, ANT1_TX. 

                                                      

 

IX In testconfig.ini file, the pathloss value is entered as positive value. 
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Figure 3-46 Pathloss entries in testconfig.ini file in WMT 

3.3.2 Device Calibration Routines 

On a UWB device, it is required to perform some internal calibration routines prior to the verification. This 

refers to the crystal calibration, Tx power calibration and ToF calibration. 

3.3.2.1 Crystal (XTAL) Calibration 

Crystal (XTAL) calibration is required to reduce the Center Frequency Offset (CFO) error of DUT within the 

specified limit. It is not channel dependent. Figure 3-47 shows the steps to create a crystal calibration routine 

and its important settings in Test Plan Editor. 

 

Figure 3-47 Create and configure a XTAL calibration routine in Test Plan Editor 

1. In Test Plan Editor, choose 'Calibration' in the standard selection field 
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 4 

36.3 dB PL@6500 MHz for FDC_ANT1_RX 

36.3 dB PL@6500 MHz for FDC_ANT1_TX 
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2. Press 'Add' to add the calibration routine 

3. Choose 'Xtal' as calibration mode 

4. Define the Xtal deviation limit, the default value 0.5 ppm can be kept, unless otherwise specified 

5. Name the calibration routine, e.g. 'XTAL Calibration CH5' 

6. Specify the connector name for both connectors in Tx and Rx direction, e.g. 'ANT1_TX', 'ANT1_RX'. The 

specified connector name should match the one in the testconfig.ini file (cf. 3.3.1 to get to know 

the association between FDC and connector) 

7. Under main menu bar, go to File > Save/Save As … to save the test plan 

After the XTAL calibration routine is run in Test Runner (cf. 3.2.2), the calibration results are presented as 

shown in Figure 3-48 where FreqErrorPPM shows 0.06 ppm which is within the limit of 0.5 ppm defined for 

this routine. The Trim parameter FREQ_DIFF on DUT is updated with the corresponding XTAL trim value 

418,09 Hz. 

 

Figure 3-48 XTAL calibration results in Test Runner 

3.3.2.2 Power Calibration 

FCC mandates the UWB device to transmit the power with maximum power spectral density to be lower than 

-41.3 dBm/MHz.  Power calibration routine is required to ensure that the UWB DUT meets this power 

requirement. The calibration needs to be done for each channel and antenna. 

 

 

1 

 

2 

 3 

 4 

 5 

 

 7 

6 

 8 

9  

 10 

 



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  43 

 

  

Figure 3-49 Create and configure a Tx power calibration routine in Test Plan Editor 

1. In Test Plan Editor, choose 'Calibration' in the standard selection field 

2. Press 'Add' to add the calibration routine 

3. Choose 'Power' as calibration mode 

4. Select the UWB channel, e.g. Channel 5 

5. Select 'MaxSpectralDensityPower' for Power Calibration Mode 

6. Define power deviation target, e.g. the default value 0.5 dBm/MHz 

7. Specify the power target '-41.8 dBm/MHz' (a worst case is considered here, i.e. it takes max power 

deviation 0.5 dBm/MHz into account to ensure that the Tx power is within the FCC limit -41.3 dBm/MHz)  

8. Name the calibration routine, e.g. 'Tx Power Calibration CH5' 

9. Specify the connector name for both connectors in Tx and Rx direction, e.g. 'ANT1_TX', 'ANT1_RX'. The 

specified connector name should match the one in the testconfig.ini file (cf. 3.3.1 to get to know 

the association between FDC and connector) 

10. Under main menu bar, go to File > Save/Save As … to save the test plan 

After the Tx power calibration routine is run in Test Runner (cf. 3.2.2), the calibration results are presented as 

shown in Figure 3-50 where the Trim parameter TX_POWER_DIFF (difference between received and 

expected Tx power) of value 12 is set on the DUT. As per NXP® UCI specification [14], this trim value 

corresponds to +3 dB. 

 

Figure 3-50 Tx power calibration results in Test Runner 

3.3.2.3 ToF Calibration 

To have precise ranging, excessive internal time delay or antenna delay between the analog antenna 

frontend and digital processing unit on a UWB device has to be determined and as a result to be 

compensated in the subsequent ranging session. The antenna delay occurs in both Tx and Rx direction. In 

Figure 3-51, the depicted time delays 𝑇𝑇𝑋 and 𝑇𝑅𝑋 on DUT side needs to be calculated which is exactly the 

task of the ToF calibration described in this section. 

 

Figure 3-51 Principle of antenna delay calibration and ToF verification (cf. Table 3-4)  
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Designation Description 

𝒕𝟎 Time of origin of the poll packet  

𝒕𝟏 Time instance when the poll packet arrives at splitter 

𝒕𝟐 Time instance when the poll packet routed back from the splitter to CMP200 

𝒕𝟑 Time instance when the DUT response packet arrives at splitter 

𝒕𝟒 Time instance when the DUT response packet arrives at CMP200 

𝑻𝒕𝒙 Travelling time of poll packet from CMP200 to splitter (t1-t0) 

𝑻𝒓𝒙 Travelling time of poll packet routed back from splitter to CMP200 (t2-t1) 

𝑻𝑹𝑶𝑼𝑵𝑫 Time difference between t4 and t2 (t4-t2). It equals the time difference between t3 and t1 (t3-t1). 

𝑻𝒕𝒐𝒇 Time of Flight 

𝑻𝑹𝑬𝑷𝑳𝒀 DUT response time (TRX+Tre+TTX) 

𝑻𝑹𝑿 DUT internal antenna delay on the receiver path 

𝑻𝑻𝑿 DUT internal antenna delay on the transmission path 

𝑻𝒓𝒆 DUT internal packet possessing time 

Table 3-4 Timings of antenna delay calibration (cf. Figure 3-51) 

The principle of antenna delay calibration is explained as follows: 

As illustrated in Figure 3-51, 𝑇𝑅𝑂𝑈𝑁𝐷 represents the time interval between the RMARKER of the poll packet 

routed back from the splitter at 𝑡2 and the DUT's response packet arriving at CMP200 analyzer side at 𝑡4. 

𝑇𝑅𝑂𝑈𝑁𝐷 is also the time difference of 𝑡3 and 𝑡1 at the splitter. The travelling time of packets from the splitter to 

CMP200 is the same, thus 𝑇𝑅𝑂𝑈𝑁𝐷 = 𝑡3 − 𝑡1 = 𝑡4 − 𝑡2. Therefore, only the right-hand side of the splitter is 

included in the time calculation during the ToF calibration and verification.  

Equation 3-1 

𝑇𝑅𝑂𝑈𝑁𝐷 = 𝑇𝑟𝑒 + 2𝑇𝑡𝑜𝑓 + 𝑇𝑅𝑋 + 𝑇𝑇𝑋 

where 𝑇𝑅𝑋 + 𝑇𝑇𝑋 represents the two-way antenna delay. 

Equation 3-2 

𝑇𝑅𝑋 + 𝑇𝑇𝑋 = 𝑇𝑅𝑂𝑈𝑁𝐷 − 𝑇𝑟𝑒 − 2𝑇𝑡𝑜𝑓 = 𝑡4 − 𝑡2−𝑇𝑟𝑒 − 2𝑇𝑡𝑜𝑓 

where 𝑡2 and 𝑡4 are the time stamps on the RMARKER of the packet measured at CMP200,  𝑇𝑟𝑒 is response 

time reported by DUT. For ToF calibration, 𝑇𝑡𝑜𝑓 is a known ToF (details of known ToF value determination is 

shown in Figure 3-52 and Figure 3-53 below). The result of Equation 3-2 is actually the calibration outcome. 

The half of 𝑇𝑅𝑋 + 𝑇𝑇𝑋 is the antenna delay that will be set as a trim value on the DUT in the end of the 

calibration routine. As a result, this updated trim value will then be adopted during the ToF verification routine 

(cf. 3.4.3). 

In OTA test solution described in this document, 𝑇𝑡𝑜𝑓 is broken down into two parts, namely, the fixed group 

delays (GD) occurring on the components of the system and the signal traveling time over the air. By 

adopting ToF kit, UWB Antenna Kit, and RF feedthrough or alternatively RF switch, the fixed GD from middle 

of splitter to the aperture of the Vivaldi antenna has a total value of 4.08 nanoseconds and 4.51 nanoseconds 

for the setup with RF feedthrough (system variant 1) and RF switch (system variant 2), respectively. Details 

of GD contribution of each component in the signal path are listed below in Table 3-5. 

Items Groupt Delay (ns) Description Comment 

 Ttof_fix_feedthrough Ttof_fix_Switch   

Tgs 0.12 0.12 Splitter (from middle to SUM port) Included in ToF kit option CM-Z300A 

Tga 0.10 0.10 AttenuatorX Included in ToF kit option CM-Z300A 

Tcable1 0.78 0.78 15 cm RF cable Included in ToF kit option CM-Z300A 

Tswitch n.a. 0.48 RF Switch SP6T Included in Antenna kit option CMQ-B744A 

                                                      

 

X The maximum group delay fluctuation among different attenuators (6, 10, 20 and 30 dB) from the ToF kit is about 15 ps. This group delay only 
applies when attenuator is connected. 
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Items Groupt Delay (ns) Description Comment 

Tfeedthr 0.05 n.a. RF feedthrough Included in CMQ200/CMQ500 standard 
configuration 

Tcable2 2.55 2.55 55 cm RF cable Included in Antenna kit option CMQ-B725A 

Tantenna 0.48 0.48 From RF feed to the aperture of the 
Vivaldi antenna  

Included in Antenna kit option CMQ-B725A 

SUM 4.08 4.51   

Table 3-5 List of fixed group delay with 6 dB attenuator in the signal path 

Figure 3-52 and Figure 3-53 show ToF calculation examples of system variant 1 and variant 2. In both cases, 

DUT's antenna (reference point) is placed 0.15 m away from the Vivaldi antenna that creates free space 

signal traveling time 𝑇𝑎𝑖𝑟 =
𝐷

𝑐∗ʋ
= 0.50 𝑛𝑠, where 𝐷 denotes the distance between the aperture of the Vivaldi 

antenna and reference point of the DUT in meter. Constant 𝑐 is the speed of light in m/ns, i.e. 0.3 m/ns. 

Velocity factor ʋ in the air equals to 1. By adding the fixed GD of 4.08 ns and 4.51 ns, the total ToF is now 

4.58 ns and 5.01 ns for system variant 1 with RF feedthrough and system variant 2 with RF switch, 

respectively. 

 

Figure 3-52 An example of ToF calculation for RF feedthrough (system variant 1) with 0.15 meter OTA distance 
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Figure 3-53 An example of ToF calculation for RF Switch (system variant 2) with 0.15 meter OTA distance  

Both fixed GD on the components (𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑓𝑒𝑒𝑑𝑡ℎ𝑟𝑜𝑢𝑔ℎ or 𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑠𝑤𝑖𝑡𝑐ℎ) and 𝑇𝑎𝑖𝑟 need to be configured in the 

ToF calibration routine.  

As required by the test routine configuration, the fixed GD 𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑓𝑒𝑒𝑑𝑡ℎ𝑟𝑜𝑢𝑔ℎ = 4.08 𝑛𝑠 or 𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑠𝑤𝑖𝑡𝑐ℎ =

4.51 𝑛𝑠 needs to be converted in distance by applying Equation 3-3 

Equation 3-3 

𝑃𝑎𝑡ℎ 𝐷𝑒𝑙𝑎𝑦 𝑖𝑛 𝑚𝑒𝑡𝑒𝑟 = 𝑇𝑡𝑜𝑓_𝑓𝑖𝑥 ∗ 𝑐 ∗ ʋ 

Where ʋ = 0.71 is velocity factor used for calculation, speed of light 𝑐 = 0.3 𝑚/𝑛𝑠 

Thus, 𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑓𝑒𝑒𝑑𝑡ℎ𝑟𝑜𝑢𝑔ℎ and 𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑠𝑤𝑖𝑡𝑐ℎ are equivalent of 0.87 m and 0.96 m in distance, correspondingly. 

Figure 3-54 shows the procedure of ToF calibration routine creation and its configurations. 
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Figure 3-54 Create and configure a ToF calibration routine in Test Plan Editor 

1. In Test Plan Editor, choose 'Calibration' in the standard selection field 

2. Press 'Add' to add the calibration routine 

3. Define antenna delay deviation value, e.g. the default value 0.5 ppm 

4. Choose 'ToF' as calibration mode 

5. Select the UWB channel, e.g. Channel 5 

6. Enter the fixed group delay, 0.96 m (𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑠𝑤𝑖𝑡𝑐ℎ for system variant 2) or 0.87 m (𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑓𝑒𝑒𝑑𝑡ℎ𝑟𝑜𝑢𝑔ℎ for 

system variant 1) 

7. Enter the free space distance between Vivaldi antenna and DUT antenna, e.g. 0.15 m 

8. Enter proper DUT Rx Power and Tx Power level. Refer to Appendix D on page 68 to learn more about 

the determination of both power levels (Attention: improper power level might lead to unstable signal 

detection at CMP200) 

9. Set ToF Verification to 'False' to indicate this is a calibration routine 
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10. Set Trim Clean ToF Ant Delay flag to 'True' to indicate that the antenna delay trim value on the DUT 

needs to be cleaned when this routine starts 

11. Set Velocity Factor to '1' as the signal propagates in air 

12. Keep the default waveform file name. 

Two waveform files should be uploaded to CMP200 before the test starts (waveform file handling, see 

Appendix E on page 69). Both waveform files are played back on CMP200 in 8 ms time interval (Figure 

3-55) that is required by DUT (NCJ29D5).  

─ Waveform file #1 (Pre_Poll packet): 

FC1T2_Data_Phr_LinPhaseRRC0p45_waveform_1_resample.wv 

─ Waveform file #2 (Poll packet):  

FC1T1ND_Ranging_LinPhaseRRC0p45_waveform_2_resample.wv 

 

Figure 3-55 Ranging message flow of NXP NCJ29D5 

13. Name ToF calibration routine, e.g. 'ToF Cal CH5' 

14. Specify the connector name for both connectors in Tx and Rx direction for ToF calibration, e.g. 

'ToF_TX', 'ToF_RX'. The specified connector name should match the one in the testconfig.ini file 

(cf. 3.3.1 to get to know the association between FDC and connector) 

15. Under main menu bar, go to File > Save/Save As … to save the test plan 

After the ToF calibration routine is executed in Test Runner (cf. 3.2.2), the antenna delay of the DUT in 

nanosecond is determined and the corresponding trim value is then set on the DUT under the trim parameter 

ANTENNA_DELAY. As example shown in Figure 3-56, the antenna delay is 4.13 ns that is translated in trim 

value 263 with 15.65 ps resolution granularity. 

 

Figure 3-56 ToF calibration results in Test Runner 

3.4 Verification 

In this chapter, verification routines for transmitter, receiver and ToF in WMT are introduced and the results 

are presented.   
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A holistic view of the recommended UWB test items for automotive NXP® chip (NXP Trimension™ NCJ29D5) 

on CMP200 is given in Table 3-6. 

Category Measurement Item (Chapter) Needed R&S Equipment and Option 

Tx / Power Preamble Power (3.4.1.1) CMP200, KM300 UWB 

Tx / Power Data Power (3.4.1.2) CMP200, KM300 UWB 

Tx / Modulation Frequency Error (3.4.1.3) CMP200, KM300 UWB 

Tx / Modulation Chip Clock Error (3.4.1.4) CMP200, KM300 UWB 

Tx / Pulse Mask 
Margin 

Pulse Mask (3.4.1.5) CMP200, KM300 UWB 

Tx / Modulation SHR/PHR/PSDU/STS NRMSE 
(3.4.1.6) 

CMP200, KM300 UWB 

Tx / Pulse Level AVG PHR/PSDU/STS Pulse Level, 
relative to SHR (3.4.1.7) 

CMP200, KM300 UWB 

Tx / Mask Transmit Spectrum Mask (3.4.1.8) CMP200, KM300 UWB 

Tx / Power Max Spectral Power [dBm/MHz] 
(3.4.1.9) 

CMP200, KM300 UWB 

Tx / Power Max Peak Spectral Power 
[dBm/50MHz] (3.4.1.10) 

CMP200, KM300 UWB 

Rx RX Sensitivity (3.4.2) CMP200, ARB Generator UWB SW Option 

ToF Ranging DS-TWR / SS-TWR 
(3.4.3) 

CMP200, ARB Generator + KM300 + ToF Kit 

Table 3-6 Measurement items for NXP Trimension™ NCJ29D5 on CMP200 

3.4.1 Transmitter 

Transmitter tests are about power, pulse level, pulse mask and transmit spectrum mask measurements. 

The SP3 is considered in all transmitter tests. Therefore, all the measurements on the data portion 

(PHR/PSDU) of the UWB frame are not available. Otherwise, SP0 should be configured. 

Follow the steps shown in Figure 3-57 to create and configure transmitter verification routine. 
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Figure 3-57 Create and configure a Tx verification routine in Test Plan Editor 

1. In Test Plan Editor, choose 'UWB' in the standard selection field 

2. Press 'Add' to add the verification routine 

3. Choose 'Tx' direction 

4. Select the UWB channel, e.g. Channel 5 

5. Select Tx measurements from the list (see Figure 3-58), e.g. Power, Modulation, Mask 
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Figure 3-58 Tx measurement items 

6. Set Power TX to '0' 

7. Set STS packet structure to '3' 

8. Name the verification routine, e.g. 'Tx Verification CH5' 

9. Specify the connector name for both connectors in Tx and Rx direction, e.g. 'ANT1_TX', 'ANT1_RX'. The 

specified connector name should match the one in the testconfig.ini file (cf. 3.3.1 to get to know 

the association between FDC and connector) 

10. Under main menu bar, go to File > Save/Save As … to save the test plan 
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Figure 3-59 Tx verification results with SP3 in WMT Test Runner 

Figure 3-59 shows the transmit test results in Test Runner after the Tx verification routine is executed (cf. 

3.2.2). 

In the subsequent chapters, description of each transmitter test and the applied pass criteria is given.  

3.4.1.1 Preamble Power 

Preamble power is the mean power of the preamble portion of the UWB PPDU. 

3.4.1.2 Data Power 

Data power is the mean power of the PHY payload of the UWB PPDU. 
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3.4.1.3 Frequency Error 

As specified in Chapter 15.4.9 of [4], the HRP UWB PHY transmit center frequency tolerance shall be ± 20 × 

10-6. The tolerance on the chipping clock given in 3.4.1.4 takes precedence over this requirement. 

3.4.1.4 Chip Clock Error 

As specified in Chapter 15.4.6 of [4], an HRP UWB transmitter shall be capable of chipping at the peak PRF 

of 499.2 MHz with an accuracy of ± 20 × 10–6. In addition, for each HRP UWB PHY channel, the center of 

transmitted energy shall be within the values listed in Table 1-1 also with an accuracy of ± 20 × 10–6. The 

measurements shall be made using a 1 MHz resolution bandwidth and a 1 kHz video bandwidth. 

3.4.1.5 Pulse Mask 

As specified in Chapter 15.4.4 of [5], for a UWB device electing to use a pulse with precursor, it is 

recommended that the transmitted pulse follows mathematical formula (Equation 1-1) of the reference root 

raised cosine pulse r(t) with a roll-off factor of β = 0.45, over at least ±3 chip periods. If the transmitted pulse 

follows the minimum precursor pulse recommendation, the transmitted pulse shape p(t) should be 

constrained by the time domain mask of Figure 3-60, where the peak of the pulse is normalized to a 

magnitude of 1 and t = 0 ns. scaled to a value of one, and the time unit is Tp, defined in Table 3-7. 

Channel Number Pulse Duration Tp (ns) Main Lobe Width Tw (ns) 

{0:3, 5:6, 8:10, 12:14} 2.00 0.5 

7 0.92 0.2 

{4, 11} 0.75 0.2 

15 0.74 0.2 

Table 3-7 Reference pulse durations in each UWB channel (Table 15-12 in [4]) 

The pulse should monotonically rise to a first peak amplitude; the first peak amplitude is defined as the 

maximum amplitude of the pulse before it first drops more than 1.25%. 

 

Figure 3-60 Time domain mask of HRP UWB PHY pulse with 2 ns Tp  

Designation Time Interval x Tp  (X-axis) Limit Value (Y-axis) 

Area 1 (Lower) [-3, 0]  -0.015 

Area 2 (Lower) [0, 2] -0.5 

Area 3 (Lower) [2, 3] -0.3 

Area 1 (Upper) [-3, -1.25] 0.015 

Area 2 (Upper) [-1.25, 1] 1.0 

Area 3 (Upper) [1, 3] 0.3 

Table 3-8 Limit line definition of pulse amplitude mask 

The result shown in Figure 3-59 gives the result in margin value, that means 
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𝑀𝑎𝑟𝑔𝑖𝑛 = 𝐿𝑖𝑚𝑖𝑡 𝑉𝑎𝑙𝑢𝑒 − 𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑑 𝑉𝑎𝑙𝑢𝑒 

So, if the margin value is > 0, then the measured value is within the mask, otherwise, the measured value 

exceeds the defined limit. 

3.4.1.6 SHR/PHR/PSDU/STS NRMSE 

Normalized Root Mean Square Error (NRMSE) measurements over SHR/PHR/PSDU/STS is based on Fira 

specification in chapter "Transmit Signal Quality" 

For SHR and STS: NRMSE < 25% 

For PHR and PSDU: NRMSE < 30% 

3.4.1.7 AVG PHR/PSDU/STS Pulse Level, relative to SHR 

Average PHR/PSDU/STS pulse level relative to SHR is based on Fira specification in chapter "Transmit 

Signal Quality". It should be no larger than ± 2dB.  

3.4.1.8 Transmit Spectrum Mask 

As specified in Chapter 15.4.5 of [4], the transmitted spectrum shall be less than –10 dB relative to the 

maximum spectral density of the signal for 0.65/Tp < |f – fc| < 0.8/Tp and –18 dB for |f – fc| > 0.8/Tp, where fc is 

the center frequency of the channel, Tp is pulse duration of the associated channel. The measurements shall 

be made using a 1 MHz resolution bandwidth and a 1 kHz video bandwidth. 

Table 3-9 gives an overview of the limit lines of the transmit PSD mask with respect to different pulse 

durations. 

Channel Number Pulse Duration Tp (ns)  |f – fc|  

  -10 dB -18 dB 

{0:3, 5:6, 8:10, 12:14} 2.00 325 MHz 400 MHz 

7 0.92 705 MHz 870 MHz 

{4, 11} 0.75 867 MHz  1067 MHz 

15 0.74 878 MHz 1081 MHz 

Table 3-9 Transmit spectrum mask limit lines 

For example, channel 9 operates at 7.987 GHz (fc) and has 2 ns pulse duration. The transmit spectrum mask 

for channel 9 is therefore shown as in Figure 3-61.  

 

Figure 3-61 Transmit spectrum mask for channel 9 
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Designation Frequency Range  (X-axis) Limit Value (Y-axis) 

Area 1 [0.65/Tp, 0.8/Tp]  -10 dB 

Area 2 > 0.8/Tp -18 dB 

Table 3-10 Limit line definition of transmit spectrum mask 

The result evaluation is based on margin, where 

𝑀𝑎𝑟𝑔𝑖𝑛 = 𝐿𝑖𝑚𝑖𝑡 𝑉𝑎𝑙𝑢𝑒 − 𝑀𝑒𝑎𝑠𝑢𝑟𝑒𝑑 𝑉𝑎𝑙𝑢𝑒 

So, if the margin value is > 0, then the measured value is within the mask, otherwise, the measured value 

exceeds the defined limit. 

3.4.1.9 Max Spectral Power [dBm/MHz] 

The maximum mean spectral power measured with 1 MHz resolution bandwidth (RBW). The power is 

measured over the PPDU or over 1 ms starting with the PPDU [15]. According to FCC requirement, max 

spectral power density should be lower than -41.3 dBm/MHz. 

3.4.1.10 Max Peak Spectral Power [dBm/50MHz] 

The maximum peak spectral power measured with 50 MHz resolution bandwidth (RBW) [15]. According to 

FCC section 15, it should be lower than 0 dBm/50 MHz 

3.4.2 Receiver Sensitivity 

Receiver sensitivity is the lowest receive signal power level at which the DUT achieves the packet error rate 

(PER) ≤ 1%. It is based on Fira specification in chapter "Packet Reception Sensitivity".  

Follow the steps shown in Figure 3-62 to create and configure Rx sensitivity test routine. 
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Figure 3-62 Create and configure a Rx verification routine in Test Plan Editor 

1. In Test Plan Editor, choose 'UWB' in the standard selection field 

2. Press 'Add' to add the verification routine 

3. Choose 'Rx' direction 

4. Select the UWB channel, e.g. Channel 5 

5. Select 'Sens' Rx measurements from the list (see Figure 3-58)  
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Figure 3-63 Select 'Sens' from Rx measurement items 

6. Select the UWB standard 

7. Specify the number of receive packets 

8. Define the initial receiver power level range (max, min) and delta value for terminating the sensitivity 

search, default settings Power Rx Max -80 dBm, Power Rx Min -110 dBm, delta 1 dB can be kept. Refer 

to Appendix F on page 70 to get insight of receiver sensitivity search 

9. Specify the receiver sensitivity limit, default setting 1% may be kept 

10. Use default value 'None' in waveform field. The waveform file will be generated on the fly via WinIQSIM. 

11. Name the verification routine, e.g. 'Rx Verification CH5' 

12. Specify the connector name for both connectors in Tx and Rx direction, e.g. 'ANT1_TX', 'ANT1_RX'. The 

specified connector name should match the one in the testconfig.ini file (cf. 3.3.1 to get to know 

the association between FDC and connector) 

13. Under main menu bar, go to File > Save/Save As … to save the test plan 

 

Figure 3-64 Rx verification results in Test Runner 

After the execution of the Rx verification routine in Test Runner (cf. 3.2.2), the result in Figure 3-64 shows 

that the PER achieves 0% (< 1% limit) at when receiver power level is at -90.31 dBm. The receiver sensitivity 

of this DUT is -90.31 dBm. 

3.4.3 ToF Ranging (SS-TWR) 

The same principle as ToF calibration shown in Figure 3-51 is considered here.  However, in ToF ranging 

verification routine, the task here is to verify the ranging distance 𝐷 or equivalently the ToF between the 

Vivaldi antenna and DUT antenna given that the DUT internal antenna delay 𝑇𝑅𝑋 + 𝑇𝑇𝑋 is known after the 

ToF calibration routine (cf. 3.3.2.3). 

Follow the steps indicated in Figure 3-65 to create and configure ToF verification routine. 
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Figure 3-65 Create and configure a ToF verification routine in Test Plan Editor 

1.  In Test Plan Editor, choose 'Calibration' in the standard selection field 

2. Press 'Add' to add the calibration routine 

3. Choose 'ToF' as calibration mode 

4. Select the UWB channel, e.g. Channel 5 

5. Enter the fixed group delay, 0.96 m (𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑠𝑤𝑖𝑡𝑐ℎ for system variant 2) or 0.87 m (𝑇𝑡𝑜𝑓_𝑓𝑖𝑥_𝑓𝑒𝑒𝑑𝑡ℎ𝑟𝑜𝑢𝑔ℎ for 

system variant 1) (cf. 3.3.2.3) 

6. Enter '0' in path delay for verification purpose 

7. Enter proper DUT Rx Power and Tx Power level. Refer to Appendix D on page 68 to learn more about 

the determination of both power levels (Attention: improper power level might lead to unstable signal 

detection at CMP200) 

8. Set ToF Verification to 'True' to indicate this is a verification routine 

9. Set Trim Clean ToF Ant Delay flag to 'False' to indicate to keep the antenna delay trim value on the DUT 

10. Set Velocity Factor to '1' as the signal propagates in air 
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11. Keep the default waveform file name. 

Two waveform files should be uploaded to CMP200 before the test starts (waveform file handling, see 

Appendix E on page 69) 

─ Waveform file #1 (Pre_Poll packet): 

FC1T2_Data_Phr_LinPhaseRRC0p45_waveform_1_resample.wv 

─ Waveform file #2 (Poll packet):  

FC1T1ND_Ranging_LinPhaseRRC0p45_waveform_2_resample.wv 

12. Name ToF calibration routine, e.g. 'ToF Ver CH5' 

13. Specify the connector name for both connectors in Tx and Rx direction for ToF calibration, e.g. 

'ToF_TX', 'ToF_RX'. The specified connector name should match the one in the testconfig.ini file 

(cf. 3.3.1 to get to know the association between FDC and connector) 

14. Under main menu bar, go to File > Save/Save As … to save the test plan 

 

Figure 3-66 ToF verification results in Test Runner 

After the ToF verification routine is executed in Test Runner (cf. 3.2.2), the verification result indicates the 

measured distance between Vivaldi antenna and DUT antenna in centimeter and the corresponding ToF in 

the air. In the result example shown in Figure 3-66, the ranging result is 15.08 cm which is quite precise (the 

physical distance between Vivaldi antenna and DUT antenna is 15 cm). 
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Figure 3-67 Measurements on PPDU of a ToF session 

In addition to WMT, CMP200 Power vs. Time (PvT) square of CMsquares delivers an overview of the ToF 

session with measurement on each PPDU that is detected by CMP200. As shown in Figure 3-67, altogether 

3 PPDUs are detected during the whole ToF session. By selecting the PPDU number in the UWB 

measurement configuration, the measurement details of the selected PPDU are presented. 
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5 Appendix 

A Data Sheet of Mini-circuits Power Splitter/Combiner ZFRSC-183+ 

 

Table 5-1 Mini-circuits Power Splitter/Combiner ZFRSC-183+ Performance Data (Source: Mini-circuits)  

B Parameters in WMT Test Plan Editor 

B.1 Common Settings 

 

Figure 5-1 Common settings 

Parameter Description Setting 

Name The name of the test routine Any 

Connector TX Connector identifier of DUT transmission path, i.e. from 
DUT to CMP200 

The name should match the corresponding section 
name in testconfig.ini file (cf. 3.3.1) 

Connector RX Connector identifier of DUT receiver path, i.e. from 
CMP200 to DUT 

The name should match the corresponding section 
name in testconfig.ini file (cf. 3.3.1) 

Direction Specify the direction from DUT's point of view TX and/or RX 

Breakpoint Mode Enable the breakpoint mode so that the test routine is 
halted that allows the user to start and check the 

Always / On Failure 
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Parameter Description Setting 

measurements in CMsquares manually given that the test 
routine supports the breakpoint feature. This is mainly 
required for debugging purposes 

Breakpoint TX Turn on/off the breakpoint for Tx test routine True / False 

Breakpoint RX Turn on/off the breakpoint for Rx test routine True / False 

Table 5-2 Common settings of a test plan in Test Plan Editor 

B.2 Configurations of Transmitter Tests 

 

Figure 5-2 Configurations of transmitter tests with STS packet structure 3 (SP3) 

Parameter Description Setting 

Additional Tasks Automatic level adjustment (auto ranging) Enable / Disable 

Bandwidth UWB channel bandwidth See Table 1-1 

Channel UWB channel See Table 1-1 

Data Rate PSDU bit rate (cf. 1.3.4). The field is hidden if STS 
packet structure 3 is chosen. 

See Table 1-5, Table 1-6 and Table 1-7 

Frequency Channel center frequency See Table 1-1 

Measurement Tx Transmitter test items Power / Modulation / Correlation / Chip Jitter / Symbol 
Jitter / Mask / PvT / Signal Info 

Mode UWB standard 802.15.4 / 802.15.4z 

Packets Tx Number of the transmitted packets 0…5000 

Payload Tx Payload for transmitter test, only required if SP0 SP0: Mandatory, e.g. 0x01,0x02,0x03 
SP3: None  

PHR Data Rate PHR data rate mode (cf. 1.3.4).  802.15.4: DRMDR 
802.15.4z: DRBM_LP / DRBM_HP / DRHM_LR / 
DRHM_HR 

PHR Rate PHR bit rate (cf. 1.3.4). The field is hidden if STS 
packet structure 3 is chosen. 

See Table 1-5, Table 1-6 and Table 1-7 

Power Tx The nominal Tx power setting -12 dBm to +14 dBm (Resolution: 0.25 dBm) 

Preamble Code 
Index 

Set the preamble code index See 1.3.3.1 

Preamble Length Number of preamble symbol repetitions (cf. 1.3.3.1) 16 / 32 /64 / 1024 / 4096  

PRF Mode Specify the PRF Mode BPRF / HPRF 

SFD Type Specify SFD type (cf 1.3.3.2) 0 / 1 / 2 / 3 / 4 (see Table 1-4) 
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Parameter Description Setting 

Statistic Tx Number of repetitions of the measurements  >0 

STS Index Specify current STS index (cf 1.3.5). The field is hidden 
if STS packet structure 0 is chosen 

See Table 1-8 

STS Length Specify STS length (cf 1.3.5). The field is hidden if STS 
packet structure 0 is chosen 

See Table 1-8 

STS Packet 
Structure 

STS packet structure defined in 802.15.4z (cf. 1.3.5) 0 / 1 / 2 / 3XI 

STS Segment 
Count 

Specify STS segment count (cf 1.3.5). The field is 
hidden if STS packet structure 0 is chosen 

See Table 1-8 

Table 5-3 Settings of Tx test in Test Plan Editor 

B.3 Configurations of Receiver Tests 

 

Figure 5-3 Configuration of receiver tests with STS packet structure 0 (SP0) 

Parameter Description Setting 

Bandwidth UWB channel bandwidth See Table 1-1 

Channel UWB channel See Table 1-1 

Data Rate PSDU bit rate (cf. 1.3.4). The field is hidden if STS 
packet structure 3 is chosen. 

See Table 1-5, Table 1-6 and Table 1-7 

Frequency Channel center frequency See Table 1-1 

Measurement Rx Select the types of receiver tests RxLevel / PER / PER Sweep / Sens 

Mode UWB standard 802.15.4 / 802.15.4z 

Packets Rx Number of receive packets 0…5000  

Packets Rx Gap Idle time between two consecutive packets sent to the 
DUT 

0…100 ms 

                                                      

 

XI NXP NCJ29D5 UCI Specification Rev. 1.16 - 7 July 2021 only supports SP0 and SP3 
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Parameter Description Setting 

Payload Payload for receiver tests. The payload should be 
specified here only if payload source is set to 'List'. The 
field is hidden if STS packet structure 3 is chosen. 

0x618801CADE9A555352434E35EC65270AB591 

Payload Length Payload length. It is not required to be set if payload 
source is set to 'List'. The field is hidden if STS packet 
structure 3 is chosen. 

0..127 

Payload MAC FCS Activates / Deactivates the MAC Frame Check 
Sequence (FCS) field. This parameter setting is only 
required if payload source is set to 'List'. The field is 
hidden if STS packet structure 3 is chosen. 

True / False 

Payload Source 
  

Select the data source 
List: A binary file  
PRBS9: Pseudo-random binary sequence (PRBS) with 
word length of 9 bits 
All0: internally generated sequence containing all 0 
data 
All1: internally generated sequence containing all 1 
data 
The field is hidden if STS packet structure 3 is chosen. 

List / PRBS9 / All0 / All1 

PHR Data Rate PHR data rate mode (cf. 1.3.4).  802.15.4: DRMDR 
802.15.4z: DRBM_LP / DRBM_HP / DRHM_LR / 
DRHM_HR 

PHR Rate PHR bit rate (cf. 1.3.4). The field is hidden if STS 
packet structure 3 is chosen. 

See Table 1-5, Table 1-6 and Table 1-7 

Power Rx Delta Specify the power difference between maximum 
receive power level and minimum receive power (cf. 
Appendix F) 

e.g. 1 dB 

Power Rx Max Specify the initial maximum receive power level (cf. 
Appendix F) 

e.g. -80 dBm 

Power Rx Min Specify the initial minimum receive power level (cf. 
Appendix F) 

e.g. -110 dBm 

Preamble Code 
Index 

Set the preamble code index See 1.3.3.1 

Preamble Length Number of preamble symbol repetitions (cf. 1.3.3.1) 16 / 32 /64 / 1024 / 4096  

PRF Mode Specify the PRF Mode BPRF / HPRF 

Sens Limit Specify the receiver sensitivity limit e.g. 1% 

SFD Type Specify SFD type (cf 1.3.3.2) 0 / 1 / 2 / 3 / 4 (see Table 1-4) 

STS Index Specify current STS index (cf 1.3.5). The field is hidden 
if STS packet structure 0 is chosen 

See Table 1-8 

STS Length Specify STS length (cf 1.3.5). The field is hidden if STS 
packet structure 0 is chosen 

See Table 1-8 

STS Packet 
Structure 

STS packet structure defined in 802.15.4z (cf. 1.3.5) 0 / 1 / 2 / 3 (see footnote XI on page Fehler! 
Textmarke nicht definiert.) 

STS Segment 
Count 

Specify STS segment count (cf 1.3.5). The field is 
hidden if STS packet structure 0 is chosen 

See Table 1-8 

Waveform Specify the waveform filename used for playback on 
the CMP200. If text 'None' is given, then the waveform 
file is generated on the fly with the parameter settings 
given in the configuration fields above.  

'None' or enter the waveform filename that has been 
uploaded in CMP200. See Appendix E for more details 
about waveform file handling. 

Table 5-4 Settings of Rx test in Test Plan Editor 



 

Rohde & Schwarz | Application Note Automotive UWB Device Testing Over the Air  65 

 

  

B.4 Configurations of ToF 

 

Figure 5-4 Configurations of ToF tests with STS packet structure 3 (SP3) 

Parameter Description Setting 

Additional Tasks Level adjustment Enable / Disable 

Ant Delay Deviation Specify the deviation of antenna delay e.g. 0.5 ppm 

Cal Mode Select the calibration mode ToF 

Channel UWB channel See Table 1-1 

First Package Delay Fix value of NXP chip (NXP NCJ29D5) 8 

Frequency Channel center frequency See Table 1-1 

   

Path Delay Fix path delay from the splitter to 
Vivaldi antenna aperture 

0.87 for system variant 1 (with RF feedthrough)XII 
0.96 for system variant 2 (with RF switch) 

Path Delay On Air Free space distance in meter /  ToF calibration routine: enter free space distance in meter between 
Vivaldi antenna and DUT antenna 
ToF verification routine: 0 

Power Rx DUT receive power level See Appendix D 

Power Tx DUT transmit power level See Appendix D 

Second Package 
Delay 

Fix value of NXP chip (NXP NCJ29D5) 16 

Statistic Count Number of the measurement 
repetitions 

>1 

STS Length Specify STS length (cf 1.3.5).  See Table 1-8 

STS Packet Structure Packet structure defined in 802.15.4z 
(cf. 1.3.5) containing STS portion 

1 / 2 / 3 (see footnote XI on page Fehler! Textmarke nicht 
definiert.) 

ToF Verification Indicate if this is a ToF verification 
routine 

True / False 

Trim Clean TOF Ant 
Delay 

Reset ToF antenna delay trim value on 
the device 

True / False 

Velocity Factor Specify the velocity factor in the air 1  

Waveform Waveform file for pre-poll (NXP 
specific) 

'FC1T2_Data_Phr_LinPhaseRRC0p45_waveform_1_resample.wv' 

                                                      

 

XII The calculated value includes the group delay on a 6 dB attenuator. For calculation details, please refer to chapter 3.3.2.3 
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Parameter Description Setting 

Waveform Poll Waveform file for poll message (NXP 
specific) 

'FC1T1ND_Ranging_LinPhaseRRC0p45_waveform_2_resample' 

Table 5-5 Settings of ToF test in Test Plan Editor 

C Test Plan Configuration File (testconfig.ini) 

To execute a test plan in Test Runner, a test configuration file needs to be assigned to each test run. 

The test configuration is a plain text file with .ini as file extension and located in sub-folder \etc under the 

WMT installation directory. As per default, the configuration file is called testconfig.ini. The filename 

can of course be user defined. 

Table 5-6 below lists the entries in an example testconfig.ini configuration file. The mnemonics in the 

square brackets indicates the beginning of a configuration section. 

Test Configuration Comment 

[general]  

testplan = testplans/UWB/test_UWB_TX_CH5.json Selected test plan 

;testplan = testplans/UWB/test_UWB_RX_PER_65_CH5.json De-selected test plan started with semi-colon in front of the line 

logs = etc/logs Logfile location 

results = etc/results Result file location 

limitcheck = True Enable limit check 

loglevel = debug Define log level (debug / info) 

results_json = False Result file in JSON format 

results_txt = True Result file in text format 

[logging]  

level = debug Level definition (debug / info) 

format = %(asctime)s %(levelname)s:%(name)s %(message)s Logging format 

[uwb]  

connection = serial Defines the connection type of DUT used by UWB verification 
routine 

port = COM3 Specify the virtual COM port of the connected DUT. Check 
Windows device manager to obtain the used COM port. 

baudrate = 460800 Defines the baud rate of the serial connection 

driver = nxp.ncj29d5.ncj29d5_uci Specify DUT's UCI control driver in WMT which is part of the WMT 
installation. The driver itself is located in the sub-folder 
dutdriver\ under the WMT installation directory 

timeout = 0.1 Serial communication time out value  

keep_open = True Keep serial port open 

[calibration] 
 

api = nxp.ncj29d5.calapi Specify the DUT calibration API which is part of the WMT 
installation. The API is located in the sub-folder calibration\ 

under the WMT installation directory 

connection = serial Defines the connection type of DUT used by UWB calibration 
routine 

port = COM3 Specify the virtual COM port of the connected DUT. Check 
Windows device manager to obtain the used COM port. 

driver = nxp.ncj29d5.ncj29d5_uci Specify DUT's UCI control driver in WMT which is part of the WMT 
installation. The driver itself is located in the sub-folder 
dutdriver\ under the WMT installation directory 
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Test Configuration Comment 

baudrate = 460800 Defines the baud rate of the serial connection 

timeout = 0.1 Serial communication time out value  

keep_open = True Keep serial port open 

[instrument] 
 

connection = socket Defines remote control interface of CMP200. A socket connection 
is used. 

host = 10.202.1.50 Specify the IP address of CMP200 

port = 5025 Specify the port number of socket connection. Port 5025 is the 
VISA default port for a raw socket connection.  

timeout = 10 Defines the remote port timeout timer 

[arbgen] 
 

enabled = True Activate the ARB generator by using WinIQSIM2 software 

connection = socket Defines socket connection to the ARB generator 

host = 127.0.0.1 Specify the IP address of ARB generator. Local host IP 127.0.0.1 
is used here, meaning the WinIQSIM2 software runs on the same 
PC as the WMT 

port = 5025 Specify the port number of socket connection. Port 5025 is the 
VISA default port for a raw socket connection. 

timeout = 5 Defines the remote port timeout timer 

[relay] 
 

enabled = True Activate the control of RF switch on CMQ chamber 

connection = socket Defines remote control interface of CMQ. A socket connection is 
used. 

host = 192.168.178.41 Specify the IP address of CMQ. This is a fixed IP. 

port = 5000 Specify the port number of socket connection. Port 5000 is a fixed 
port number for CMQ chamber 

timeout = 5 Defines the remote control timeout timer 

termchar = \r Define the termination character of the remote control command 

driver = wmt.equipment.cmq Specify CMQ control driver which is part of the WMT installation. 
The driver is located in sub-folder wmt\equipment under WMT 

installation directory. A driver named cmq is used in this example 

[ANT1_TX] Section name ANT1_TX can be user defined. This is the identifier 
of the connection. The name should match the one entered in 
Connector TX field of the common setting part of the Test Plan 
Editor (see Table 5-2) 

connector = Port1.IFIn Specify the Port1.IFIn connector on CMP200 according to the 
physical cable connection 

fdc = FDC_ANT1_TX Specify the FDC table name that is associated to this connection 

relay = 1.1.1 Specify the relay position in CMQ (cf. 3.1.1.6) 

[ANT1_RX] Section name ANT1_RX can be user defined. This is the identifier 
of the connection. The name should match the one entered in 
Connector RX field of the common setting part of the Test Plan 
Editor (see Table 5-2) 

connector = Port1.IFOut Specify the Port1.IFOut connector on CMP200 according to the 
physical cable connection 

fdc = FDC_ANT1_RX Specify the FDC table name that is associated to this connection  

relay = 1.1.1 Specify the relay position in CMQ (cf. 3.1.1.6) 

[FDC_ANT1_RX] FDC named FDC_ANT1_RX 

6500.0 = 36.3 Frequency in MHz, attenuation in dB (see Table 3-3) 

8000.0 = 38.4 Frequency in MHz, attenuation in dB (see Table 3-3) 

[FDC_ANT1_TX] FDC named FDC_ANT1_TX 
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Test Configuration Comment 

6500.0 = 36.3 Frequency in MHz, attenuation in dB (see Table 3-3) 

8000.0 = 38.4 Frequency in MHz, attenuation in dB (see Table 3-3) 

Table 5-6 Example of a testconfig.ini file 

D Power Level Settings for ToF Testing 

As illustrated in Figure 3-51, when performing ToF calibration/verification, CMP200 receives two packets at 

time instance 𝑡2 and 𝑡4 on which the 𝑇𝑅𝑂𝑈𝑁𝐷 calculation is based. The power level of these two packets at the 

CMP200 IFin port should fulfill following criteria to ensure the stable signal detection: 

1. absolute power level of both detected packets 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃1 and 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃2 arriving at 𝑡2 and 𝑡4 at 

CMP200 IFin port should be no less than -50 dBm, respectively, where 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃1 is the power level of 

the poll packet routed back from the splitter, 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃2 is the power level of the DUT's response 

packet. 

2. the relative power level difference between 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃1 and 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃2 should be no larger than 10 dB 

In case the criteria are not fulfilled, the attenuators coming along with the UWB ToF Kit (R&S CM-Z300A) can 

be added in the signal path to adjust the power level. 

 

Figure 5-5 Power level consideration for ToF calibration/verification 

Hereafter are the equations that are used for the power level calculations. 

Equation 5-1 

𝑃𝐷𝑈𝑇_𝑅𝑥 = 𝑃𝐶𝑀𝑃_𝐼𝐹𝑜𝑢𝑡 − 𝑂𝑣𝑒𝑟𝑎𝑙𝑙 𝑃𝑎𝑡ℎ𝑙𝑜𝑠𝑠 

where overall pathloss on the signal path is given in Table 3-3. 𝑃𝐷𝑈𝑇_𝑅𝑥 is the DUT receive power that needs 

to be entered (power RX, cf. Chapter 3.3.2.3, Chapter 3.4.3 and Appendix B.4) in Test Plan Editor for the 

ToF calibration/verification routine. 𝑃𝐶𝑀𝑃_𝐼𝐹𝑜𝑢𝑡 is the output power level at the IFout port of CMP200. 

Equation 5-2 

𝑃𝐷𝑈𝑇_𝑇𝑥 < 14 dBm 

𝑃𝐷𝑈𝑇_𝑇𝑥 is the DUT transmit nominal power that needs to be entered (power TX, cf. Chapter 3.3.2.3, Chapter 

3.4.3 and Appendix B.4) in Test Plan Editor for the ToF calibration/verification routine. This is the value 

specified by DUT vendor. In our example here, it is defined by NXP in [14]. 

Equation 5-3 
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𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃1 = 𝑃𝐶𝑀𝑃_𝐼𝐹𝑜𝑢𝑡 − 𝑃𝑎𝑡ℎ𝑙𝑜𝑠𝑠1 

where pathloss1 denotes the loss on 2 cables (2 meter of each) connected between CMP200 and splitter, 

and isolation between port1 and port2 of the splitter. Typical pathloss on a cable is about 2.2 dB. The exact 

isolation of the splitter in the operation frequency can be found in the datasheet of the splitter in Appendix A.  

Equation 5-4 

𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃2 = 𝑃𝐷𝑈𝑇_𝑇𝑥 − 𝑂𝑣𝑒𝑟𝑎𝑙𝑙 𝑃𝑎𝑡ℎ𝑙𝑜𝑠𝑠 

After the DUT power RX 𝑃𝐷𝑈𝑇_𝑅𝑥 and power TX 𝑃𝐷𝑈𝑇_𝑇𝑥 are configured for the ToF calibration/verification 

routine, all power levels at CMP200 side 𝑃𝐶𝑀𝑃_𝐼𝐹𝑜𝑢𝑡, 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃1 and 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃2 are determined by applying 

the equations given above. Check the mentioned two criteria at the beginning of this chapter to see if the 

criteria are fulfilled, if not, try to go another iteration by adjusting the different 𝑃𝐷𝑈𝑇_𝑅𝑥 and 𝑃𝐷𝑈𝑇_𝑇𝑥 value until 

the criteria are met. 

In the following example, DUT is positioned 15 cm apart from Vivaldi measurement antenna. The chamber is 

equipped with RF switch (system variant 2). No attenuator is connected in the signal path. The tested UWB 

channel is 5 (6.5 GHz). With this setup and configuration, the power level and pathloss applied for the level 

calculation are listed in Table 5-7 below.  

Power Level/Pathloss Value Remark 

𝑷𝑫𝑼𝑻_𝑹𝒙 -64 dBm DUT Rx power level configured in WMT 

𝑷𝑫𝑼𝑻_𝑻𝒙 2 dBm DUT Tx power level configured in WMT 

𝑶𝒗𝒆𝒓𝒂𝒍𝒍 𝑷𝒂𝒕𝒉𝒍𝒐𝒔𝒔 36,3 Lookup Table 3-3 (system variant 2, with 6 dB attenuator) 

𝑷𝑪𝑴𝑷_𝑰𝑭𝒐𝒖𝒕 -27.7 dBm Apply Equation 5-1 

𝑷𝑪𝑴𝑷_𝑰𝑭𝒊𝒏_𝑷𝟐 -34.3 dBm Apply Equation 5-4, > -50 dBm  

𝑷𝒂𝒕𝒉𝒍𝒐𝒔𝒔𝟏 10.62 dB (2 x 2.2 dB on cable + 6.22 dB isolation) Fixed value 

𝑷𝑪𝑴𝑷_𝑰𝑭𝒊𝒏_𝑷𝟏 -38.32 dBm Apply Equation 5-3, > -50 dBm 

| 𝑷𝑪𝑴𝑷_𝑰𝑭𝒊𝒏_𝑷𝟏- 𝑷𝑪𝑴𝑷_𝑰𝑭𝒊𝒏_𝑷𝟐 | 4.02 dB  < 10 dB 

Table 5-7 Example of power level settings for ToF calibration/verification  

With the settings given in this example, the power level criteria are fulfilled, i.e. 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃1and 𝑃𝐶𝑀𝑃_𝐼𝐹𝑖𝑛_𝑃2 are 

higher than -50 dBm. And difference of them is 4.02 dB which is lower than 10 dB. The calculation confirms 

that 𝑃𝐷𝑈𝑇_𝑅𝑥 and 𝑃𝐷𝑈𝑇_𝑇𝑥 values entered in WMT Test Plan Editor are valid. 

A calculator called 'UWB Power Level Calculation' is available in Gloris (https://gloris.rohde-schwarz.com/) 

for download. With this tool, the determination of 𝑃𝐷𝑈𝑇_𝑅𝑥 and 𝑃𝐷𝑈𝑇_𝑇𝑥 is becoming much easier. 

E Waveform File Handling 

Waveform file or ARB file are required for receiver or ToF tests. Before the test routine is started, make sure 

that required waveform file is available on CMP200. If this is not the case, then the waveform file (.wv) needs 

to be uploaded to CMP200 via CMsquares beforehand. 

The upload operation in CMsquares is shown in Figure 5-6. 

https://gloris.rohde-schwarz.com/
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Figure 5-6 Upload waveform file on CMP200 from CMsquares 

1. Access to CMsquares by entering the CMP200's IP address in the Web browser on the control PC. After 

the CMsquares (Web interface of CMP200) is loaded, click on the burger menu 

2. In the drop-down menu, select 'File Explorer' 

3. Navigate to 'waveform' folder in the opened file explorer in CMsquares 

4. Select the waveform file that is intended to be uploaded and press 'Upload' button.  

For the receiver tests, there is an alternative way to handle the waveform file. If no ARB file is explicitly 

specified in Test Plan Editor of the test routine ('None' is set in Waveform parameter configuration field), then 

the ARB file will be generated on the fly by WinIQSIM2 software on the local control PC based on the 

parameter settings of receiver test in the Test Plan Editor. The generated ARB file will be transferred to 

CMP200 afterwards during the test execution. For doing that, WinIQSIM2 needs to be launched and running 

in the background before test routine is executed. 

F Receiver Sensitivity Search 

Figure 5-7 illustrates the flow chart of receiver sensitivity search. The initial maximal receiver power level 

𝑃_𝑀𝑎𝑥 and minimum receiver power level 𝑃_𝑀𝑖𝑛, as well as the 𝐷𝑒𝑙𝑡𝑎 value are the parameters that need to 

be configured in the receiver sensitivity routine as described in 3.4.2 and Appendix B.3.  

The sensitivity search starts with receiver power level at (𝑃_𝑀𝑎𝑥 + 𝑃_𝑀𝑖𝑛)/2. During the search, the 𝑃_𝑀𝑎𝑥 

and 𝑃_𝑀𝑖𝑛 will be changed dynamically based on the measured PER and comparison with the target 

sensitivity limit. The iteration keeps on running till both 𝑃_𝑀𝑎𝑥 and 𝑃_𝑀𝑖𝑛 values converge somehow with a 

power difference of 𝐷𝑒𝑙𝑡𝑎 dB.   

Parameter settings of 𝑃_𝑀𝑎𝑥 , 𝑃_𝑀𝑖𝑛 and 𝐷𝑒𝑙𝑡𝑎 can influence the speed and accuracy of the receiver 

sensitivity search. 
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Figure 5-7 Flow chart of receiver sensitivity search 
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